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Before you install

About the Klocwork packages and components
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

The Klocwork Insight installation packages and components allow you to install only the
components you need on a specific machine.

The main installation packages are:

Ä Server (kw-server-installer)
Ä User (kw-user-installer)

Note: The Distributed Analysis package is covered separately in Installing the Distributed
Analysis package.

Server package components

Component Details

Database Server MySQL database server (command-line name: database). Contains data for Klocwork Review and Klocwork Architect.
You can also use your own separate installation of MySQL.

Default host: localhost

Default port: 3306

License Server A FLEXlm license manager (command-line name: license). You can also use your organization's FLEXlm server.

Default host: localhost

Default port: 27000 plus 33133

Klocwork Server An Apache Tomcat Web server (command-line name: klocwork). Provides access to Klocwork Review, Klocwork Inspect
and Klocwork documentation. Klocwork clients connect to the Klocwork Server for project information.

Note: Klocwork does not support using your own Apache Tomcat server. You must use the Web server packaged with
Klocwork.

Default host: localhost

Default port: 8080 plus 8081

Klocwork build tools Integration build analysis tools:

Ä tools for managing Klocwork projects, analysis and access control (kwadmin and kwbuildproject)
Ä tools to produce a build specification (kwinject, kwwrap, kwant, kwcsprojparser)
Ä tools for running Klocwork integration build analysis (the analysis engines)
Ä tools for managing Klocwork projects and access control
Ä sample projects

Klocwork
projects_root

directory 

The data location for the Klocwork Servers and applications, including the project database tables, which are stored in
MySQL and Lucene databases. For information about default location and special considerations for this data directory,
see Projects_root directory.
Note: The projects_root directory is not one of the components you see listed in the installation wizard, but the wizard lets
you choose a location for it.

http://www.klocwork.com/products/documentation/dakota/index.php?title=File:Klocwork-insight-config.png
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_an_external_MySQL_server_with_Klocwork
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_your_organization%27s_FLEXlm_server
http://www.klocwork.com/products/documentation/dakota/index.php?title=Integration_build_analysis
http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
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User package components

Component Details

Klocwork
Architect

(part of GUI/Web
tools)

Extracts an accurate graphical view of the design of your organizationÄs software directly from existing source code (C/C++
and Java)

Klocwork
command line 

Command-line versions of the Klocwork developer tools for C/C++ and Java, which allow software developers to verify the
quality of source code before they commit it to source control. Also includes Klocwork Desktop, a GUI alternative to running
kwcheck.
Note: This component also includes the Klocwork Extensibility API for writing custom checkers.

IDE integration
(plug-ins) 

Klocwork developer tool plug-ins for C/C++, C# and Java, for supported IDEs.

Checker Studio Allows you to browse the Abstract Syntax Tree (AST) structure of your code to help you identify nodes of interest in order to
create custom C/C++ or Java KAST checkers.

Note: The specific IDE plug-ins are only visible during installation if the relevant IDEs are installed on your
machine. For example, if you do not have Microsoft Visual Studio 2005 installed, you will not see "Klocwork for
C/C++ in Visual Studio 2005".

System requirements
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Supported platforms
Both the Klocwork Server and User packages are supported on the following operating systems (except where
noted). This means that Klocwork has performed the full test suite on these operating systems with certain hardware
and will provide technical support as specified in the Klocwork support policies.

Note: It is not possible to use Klocwork tools with SELinux (Security-Enhanced Linux) enabled.

Processor Operating system

Sun SPARC Sun Solaris 9 and 10

Intel and
AMD

32 bit and
64 bit

Red Hat Enterprise Linux 4.x, 5.x, 6.x
SUSE Enterprise 10 (32-bit only), 11
In addition Klocwork supports all recent Linux distributions such as Fedora, Open Suse, Ubuntu, CentOS and Debian running glibc
2.3 or greater (use getconf GNU_LIBC_VERSION to find out your version). If you have any questions about your distribution, please
contact Customer Support.

Windows 7
Windows Server 2008
Windows Server 2003
Windows XP Professional
Windows Vista

Mac OS X Snow Leopard (10.6)
Mac OS X Lion (10.7)

IBM Power5
64 bit

IBM AIX 5.3, TL 7 (Server package only)

http://www.klocwork.com/products/documentation/dakota/index.php?title=System_requirements%23Supported_IDEs
http://www.klocwork.com/products/documentation/dakota/index.php?title=Creating_C/C%2B%2B_KAST_checkers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Creating_Java_KAST_checkers
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Operating system patches and packages
The following patches or packages are required for running Klocwork products (either server or user installations) on
certain operating systems. They are in addition to the regular maintenance patches for your operating system.

If you are installing
on...

you need...

Solaris 9 GTK
Note: The minimum version required to run Klocwork Desktop, part of the Klocwork Desktop Command Line in the User
Package, is GTK 2.2.1.
To install GTK, perform the following steps:
Switch to super user:
$ su -

Make sure the pkg-get tool is installed.
Update your local copy of the catalog (optional):
# pkg-get -U

Download and install GTK and all its dependencies automatically:
# pkg-get -i gtk

Switch back to the normal user:
# exit

Note: pkg-get installs all software to /opt/csw. Export the LD_LIBRARY_PATH environment variable to
/opt/csw/lib before running GTK.

Solaris 9 or 10 The patches required for Java 1.6. Klocwork installs and uses Java 1.6. The requirements for Java are listed in the Sun
release notes:
[1]
This page also provides a link for downloading recommended and required patches.

The zlib package (not required if you are installing only Klocwork Architect or Klocwork developer tools).
Check that the zlib package is installed. To check that the zlib package is installed, either run
$ pkginfo |grep zlib

or look for a file called libz.so under /usr/lib or /usr/local/lib.
If the zlib package is installed, you will see the package SUNWzlib, or SMCzlib, or both packages.

Linux x86, 64-bit The 32-bit compatibility libraries must be installed. Klocwork Insight works on 64-bit platforms in 32-bit emulation mode,
so in order for Klocwork Insight to work on Linux 64-bit platforms, you must ensure that the 32-bit libraries are installed.
The way you check and install 32-bit libraries depends on your Linux distribution. For example, for Ubuntu, run the
following command to install 32-bit compatibility libraries:
$ sudo apt-get install ia32-libs

The 32-bit version of the libncursesw library must be installed.

Ä For Fedora Core and Redhat Enterprise Linux, run these commands:

$ sudo yum install ncurses-libs.i686 (or your distributionÄs equivalent)

This library is optional and only required if you need to run the mySQL command line tools.

$ sudo yum install glibc.i686

$ sudo yum install libgcc.i686

Ä For Ubuntu (except v8.04), run this command:

$ sudo apt-get install lib32ncursesw5

Ä For Ubuntu 8.04:

Download a .deb file from [2]

Run this command:

$ sudo dpkg --install lib32ncursesw5_5.7+20090207-1ubuntu1_amd64.deb

Any Linux
distribution that does
not install the X11
version of X Window
by default

xorg-XFree86-deprecated-libs

http://java.sun.com/javase/6/webnotes/install/jre/install-solaris.html#requirements
http://packages.ubuntu.com/jaunty/lib32ncursesw5
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Red Hat Enterprise
Linux (RHEL) 4

libpng10-1.0.13-8.i386.rpm

Ubuntu 6.06 libxp-dev

Operating systems that support Flexera FLEXnet ID Dongles
A FLEXnet ID Dongle is a hardware key, also referred to as a dongle, used to lock software access to the machine on
which it is physically installed.

You can use FLEXnet ID Dongles in situations where you:

Ä cannot release any system information such as MAC addresses or IP addresses
Ä cannot share a license server between multiple sites

There is more information on FLEXnet ID Dongles on the Flexera Web site.

To use Flexera FLEXnet ID Dongles, use one of the following operating systems with the appropriate FLEXnet
driver, with HOSTID_FLEXid9 using FLEXnet 11.10.1.0. You can obtain the appropriate driver for your operating
system from Klocwork Customer Support.

Operating system FLEXnet driver installer

Ä Red Hat Enterprise Linux 4.x, 5.x, 6.x aksusbd-redhat-1.8.1-3.i386.rpm

Ä Windows 2000 Professional
Ä Windows Server 2003
Ä Windows XP Professional

FLEXidInstaller.exe, FLEXid.exe or FLEXidsilent.exe

Ä Windows Vista (32 bit and 64 bit) FLEXId_Dongle_Driver_Installer.exe (choose the FLEXid9 driver)

Notes:

Ä You must install Flexera FLEXnet ID Dongles at the root/Administrator privilege. For Unix, use su/sudo. For
Windows, use an Administrator group.

Ä After installing Flexera FLEXnet ID Dongles on Windows, restart the Klocwork Servers.
Ä The Linux Red Hat Package Manager (RPM) installer emits an error message about checkpc. Ignore the error

message.

Disk space requirements

Disk space requirements for installation
A complete installation requires 400 to 450 Mbytes for installation. Additional disk space is required temporarily
during installation.

Disk space requirements for data storage
Klocwork Insight data includes the source files, configuration files, object files, tables, and the database. The total
disk space needed for a single integration-build analysis will be the total of all this data. If you use Klocwork
incremental analysis, the object file size and table size is needed only once per project.

Some sample projects to show how size can vary

http://www.klocwork.com/products/documentation/dakota/index.php?title=Incremental_analysis
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Project Language Lines of code Object file
size
(Mbytes)

Table size (Mbytes) Database size (Mbytes) Total size (Mbytes)

Boost C/C++ 6,300 393 17 84 494

Firefox C/C++ 1,200,000 2,800 606 702 4,108

X.org C 1,500,000 2,600 608 720 3,928

Linux C 2,300,000 7,200 1,100 1,200 9,500

Common C++ C/C++ 20,000 168 23 45 236

Python C 192,000 114 52 84 250

MySQL C/C++ 350,000 781 133 167 1,081

Processor and RAM requirements
Server and complete installations

Ä Processor speed: 2 GHz or better
Ä RAM: Minimum 2 Gbytes for a single core machine and a minimum of 1 GB of memory per processor or core on

multicore machines. More than 2 Gbytes may be required for very large analyses. Note that the size of a build and
its RAM requirements depend not only on the lines of code, but also on the number and complexity of
relationships in the code.

User installations

Klocwork client Processor speed RAM

Klocwork for C/C++ 1 GHz or better 1 Gbyte. On Windows and with precompiled headers, the minimum RAM is 2 GB.

Klocwork for Java 1 GHz or better 1 Gbyte.

Architect 1 GHz or better 1-2 Gbytes recommended

Klocwork Review and Klocwork Inspect 1 GHz or better 1-2 Gbytes recommended

Java Virtual Machine requirements

Windows
If you don't have Java 1.6 Update 45 installed, the Server, User or Distributed Analysis installation package will
install Java 1.6 Update 45. It will be installed in <server_install>/_jvm/bin/ and
<user_install>/_jvm/bin/. Your system must meet the requirements [3] for this version of Java.

If you have a later update of Java 1.6, Java will not be installed, and Insight will use the already installed version.

The installation package detects whether you have a 32-bit or 64-bit operating system and installs the appropriate
version of Java.

http://java.sun.com/javase/6/webnotes/install/system-configurations.html
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Linux and Solaris
Insight installs Java 1.6 Update 45. Your system must meet the requirements [3] for this version of Java.

On Linux, there is a separate installation package for both 32-bit and 64-bit Java. Select the one that matches your
operating system.

Only 32-bit Java is supported for Solaris.

Mac
You must install JVM 1.6 Update 45 or later on your machine before installing the Klocwork Server or User
package. If you have a previous JVM version installed and you try to install the Server or User package, you will see
the error message, "Version of Java is too old". Apple supplies their own version of Java. Use the Software Update
feature on your Mac.

Only 32-bit Java is supported for Mac.

AIX
Insight installs and uses IBM Java 1.6, so your system must meet the requirements for Java 1.6. At the time of
publication, the link to supported system configurations for IBM Java 1.6 was:

http:/ / www. ibm. com/ developerworks/ java/ jdk/ aix/ service. html

Only 32-bit Java is supported for AIX.

IDE plug-ins
The Klocwork Desktop Java Plug-ins for Eclipse and IntelliJ IDEA require Java 1.6. You must ensure that your IDE
is running on Oracle (Sun) Java 1.6.

Supported IDEs
Note: Klocwork Insight also has successful integrations with other Eclipse-based IDEs.

Supported C/C++ IDEs

IDE Version

Eclipse 3.4, 3.5, 3.6, 3.7 and 4.2

Wind River Workbench 3.1, 3.2, 3.3

QNX Momentics 4.6, 4.7

Microsoft Visual Studio .NET 2005, .NET 2008, .NET 2010 and .NET 2012. The Express edition of Visual Studio is not supported.

http://java.sun.com/javase/6/webnotes/install/system-configurations.html
http://www.ibm.com/developerworks/java/jdk/aix/service.html
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Supported C# IDEs

Klocwork C# analysis is available for Microsoft Visual Studio .NET 2005, 2008, 2010 and 2012. The Express
edition of Visual Studio is not supported.

The Smart Device project type is not supported.

Supported Java IDEs

IDE Version

Eclipse 3.4, 3.5, 3.6, 3.7, 4.2

JetBrains IntelliJ IDEA 10.0, 10.5, 11.x, 12.x

IBM Rational Application Developer for WebSphere 7.5.x at the level of "Ready for IBM Rational Software" for Eclipse-based solutions

Supported browsers
A browser is required for Klocwork Architect reports, for Klocwork Review, and for Klocwork Inspect.

Ä Mozilla Firefox - the current, latest release except for the AIX platform, which is at 3.5.13.1
Ä Internet Explorer 8* and 9
Ä Apple Safari 5.x
Ä Google Chrome - the current latest release

*Not supported for Klocwork Inspect

Note: Klocwork Review and Klocwork Inspect also require that you enable cookies in your browser.

Supported PDF readers
Required for viewing reports in Klocwork Architect.

Ä Adobe Acrobat Reader 5.0 or higher

Python
Ä On Unix, the Insight installation will install Python 2.7 if it is not detected on your machine.

Supported source code management systems for Klocwork Inspect
Inspect has been tested with the following, for both pre-checkin and post-checkin code reviews:

SCM Supported plug-ins

Base ClearCase 7.x Eclipse, IntelliJ IDEA

CVS 1.12.x Eclipse, IntelliJ IDEA

Git 1.7.x Eclipse, IntelliJ IDEA

TFS 2010 Command-line only*

Perforce Visual Client 2010.x Command-line only*

Subversion 1.4.x, 1.6.x, 1.7.x Eclipse, IntelliJ IDEA

*All of the SCM's are supported by using the commands kwcodereview (pre-checkin) or kwscm (post-checkin) on
the command-line.

For other SCMs, please contact Klocwork Customer Support [4].

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwcodereview
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwscm
mailto:support@klocwork.com
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C/C++ compilers supported for build integration
As part of creating a build specification, Klocwork Insight automatically searches for the following compiler types
by default. If your compiler is not on this list, contact Klocwork Customer Support [4] so that we can support your
compiler. For details on compilers and on creating build specifications generally, see Creating a C/C++ build
specification.

Compiler type Klocwork compiler code Names of common compiler variants Introduced Improved

Analog Devices Blackfin and
TigerSHARC

dsp ccblkfn, ccts 9.5

ARM armcc
armlink
ar

armcc, armcpp, tcc, tcpp
armlink
armar

Pre-9.5

CADUL C cross compiler for
Intel 80X86

cadul_compile
cadul_link

ccu38o
lnku38a

9.6

Clang gnu clang
clang++

9.6 SR3

CodeWarrior Freescale S12 chc12 chc12 9.5

Compiler caching tools ccache ccache, distcc 9.5

Cosmic cosmiccompile
cosmiclink

cxs12x, cx6812, cx6816, cxstm8
clnk

9.5 9.6

Embarcadero compiler/linker bcc
blink

bcc32
ilink32

9.5

Fujitsu FR Family fcc fcc911s, fcc907s 9.5

GNU gnu
gnu_ld

gcc, g++, cc, c++
ld

Pre-9.5

GNU ar ar ar Pre-9.5

Green Hills GHS ghs
ghscom
ghslink
ghsar

gcc, gcx, ccarm, cxarm, ccmips, cxmips, ccintppc,
cxintppc
ecomarm, ecomppc
elxr
ax

Pre-9.5 9.6

Hexagon Tools qdsp qdsp-gcc, qdsp-g++ 9.5

HI-TECH C compiler/linker picc
piclink

picc
hlink

9.6

Hitachi ch38 ch38 ch38.exe Pre-9.5

IAR Systems C
compiler/linker for 8051/NEC
V850/MSP430/M16C/Renesas
RX210/CR16C/ARM/Atmel
AVR
(see Limitations)

icc8051
iccv850
icc430
xlink
iccm16c
iar_rx_compile
iar_rx_link
icccr16c
iccarm
ilinkarm
iar_avr_compile_filter

icc8051
iccv850
icc430
xlink
iccm16c
iccrx
ilinkrx
icccr16c
iccarm
ilinkarm
iccavr

Pre-9.5 9.6

IBM XL C/C++ xlc cc, xlc, xlC and related commands (see
<klocwork_install>/config/kwfilter.conf

for full list)

9.5

mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Creating_a_C/C%2B%2B_build_specification
http://www.klocwork.com/products/documentation/dakota/index.php?title=Creating_a_C/C%2B%2B_build_specification
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Limitations_for_build_integration
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ImageCraft AVR iccavr iccavr 9.5

Intel C++ icc
icl

icc, icpc
icl

Pre-9.5

Intel iC-386 c386 c386a 9.6

Keil CA51 c51
lx51

c51, cx51, c166, c251
lx51, l166, l251

9.5 9.6

MetaWare High C/C++ arc
ararc
ldarc
mcc

hcarc, hcac
ararc, arac
ldarc, ldac
mcc

Pre-9.5 9.5

Metrowerks CodeWarrior mwc mwcc, mwccmcf Pre-9.5

Microchip MPLAB pic24 pic30 pic30-gcc 9.5

Microsoft Visual C++ mscompile
mslink

cl, clarm
link, lib

Pre-9.5

Microtec mcx
mlk

mcx
mlk

9.5

Motorola DSP563 moto563compile
moto563link

g563c
dsplnk

9.6

MPLAB C18 mcc18
mplink

mcc18
mplink

9.5

Nvidia CUDA nvcc nvcc 9.6

Panasonic C cc103S
ld103S

cc103S
ld103S

9.5

Paradigm C/C++ pcc
plink

pcc
plink

9.6

Plan 9 C plan9
ar

0c, 1c, 2c, 5c, 6c, 7c, 8c, 9c, kc, qc, vc
ar.l

9.5

QNX qnx qcc Pre-9.5

Renesas 78K0R ren_cc78
cc78k0r

ren_lk78
lk78k0r

9.6

Renesas SuperH and RX
family

rxcompile
rxlink

rxc, shc
optlnk

9.5

Renesas R8C and M16C
families

nc30 nc30 9.5

Renesas V850 ca850
ld850

ca850
ld850

9.5

Star Core Freescale scc
sc100-ld

scc
sc100-ld

Pre-9.5

Sun Studio C/C++ sun CC, cc Pre-9.5

Tasking Classic Toolset for
C166 compiler/linker

tasking_classic_166_compile
tasking_classic_166_link

cc166
l166

9.5 9.6

Tasking IFX SLE88 cj2 cj2 9.5

Tasking Tricore tricore_compile
tricore_link

cctc
ltc

9.5

Tasking VX Toolset for C166
compiler/linker

tasking_166_compile
tasking_166_link

cc166
lk166

9.6
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Tensilica Xtensa C/C++ xtensa xt-xc
xt-xc++

9.6

TI ARP32 C/C++ cl_arp32 cl-arp32 9.5

TI msp430 C/C++ cl430 cl430 9.5

TI tms320c6x and
tms320c55x

cl6x
link6x
ar6x

cl6x, cl55
link6x
ar6x

Pre-9.5

TI tms320c28x cl2000
lnk2000
ar

cl2000
lnk2000
ar2000

9.5

TI tms470 cl470
lnk2000
ar

cl470
lnk470
ar470

9.6

TriMedia tmcc tmcc tmcc, tmCC Pre-9.5

WinAVR gnu
ar

avr-gcc, avr-g++
avr-ar

9.6

Wind River Diab diab
dld
ar

dcc, dplus
dld
dar

Pre-9.5

Wind River GCC gnu ccppc 9.5

ZiLOG eZ80 ez80cc
ez80link

ez80cc
ez80link

9.5

Supported C# language specifications
Klocwork Insight support versions 1.0, 2.0 and 3.0 of the C# language specification.

Application servers supported by Klocwork JSP scanning
KlocworkÄs JSP scanning supports the following application servers:

Application server Version

Apache Tomcat 5.5, 6.0

BEA WebLogic 10

Supported versions of MySQL
For Windows, Linux and Mac, the Database Server is a MySQL 5.1.68 database server. For Solaris and AIX, the
Database Server is a MySQL 5.1.66 database server. If you want to use your own manually installed MySQL
database server, it must be the appropriate version. If necessary, upgrade your separate MySQL database before you
install or upgrade Klocwork Insight.

Supported LDAP servers
Ä Windows Server 2003: Microsoft Active Directory
Ä Windows Server 2008: Microsoft Active Directory
Ä Linux: OpenLDAP
Ä Sun Java System Directory
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Ä Novell eDirectory

References
[1] http:/ / java. sun. com/ javase/ 6/ webnotes/ install/ jre/ install-solaris. html#requirements
[2] http:/ / packages. ubuntu. com/ jaunty/ lib32ncursesw5
[3] http:/ / java. sun. com/ javase/ 6/ webnotes/ install/ system-configurations. html
[4] mailto:support@klocwork. com

http://java.sun.com/javase/6/webnotes/install/jre/install-solaris.html#requirements
http://packages.ubuntu.com/jaunty/lib32ncursesw5
http://java.sun.com/javase/6/webnotes/install/system-configurations.html
mailto:support@klocwork.com
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Upgrading from a previous version

Upgrading from a previous version
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Before you begin

IMPORTANT NOTICES
If you are upgrading from version 8.x, you will need a new license for version 9.6. Contact Customer Support [4].

If you are upgrading from version 9.1 or earlier: The database schema changed significantly in version 9.2. As a
result, the migration script runs a MySQL database integrity check, which takes a significant amount of time. To
reduce the amount of time required for migration, we strongly recommend that you delete unneeded projects and
failed builds before migration, as detailed in the procedure that follows.

We also recommend that you make a copy of your projects_root directory and migrate the copy. This way, users
can continue to use Klocwork Review, though they should be instructed not to make any changes, such as changing
an issue's status.

If you do not use the default server settings, you will need to specify your custom settings prior to beginning the
upgrade. Otherwise, during the installation these settings will revert back to the default settings. If you forget, you
can always go in and change the settings for each of your environments after you have completed upgrading.

To avoid losing issues, status changes or comments from the last release in your first release 9.6 analysis run, make
sure you read Before your first 9.6 integration build analysis.

See also:

Ä Changes affecting migration
Ä Changes to licensing
Ä Limitations for installation, upgrade and deployment

Supported upgrade paths
Upgrade from the most recent service release of a major release is supported.

Due to database schema and license changes, we recommend a particular path when upgrading from previous
versions of Klocwork Insight. Find your current version in the chart below and follow the appropriate path. If you
are upgrading from a release earlier than 8.0, contact Customer Support [4] for further instructions.

mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Upgrading_from_a_previous_version%23Before_your_first_version_9.6_integration_build_analysis
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Changes_affecting_migration
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Changes_to_licensing
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Limitations_for_installation%2C_upgrade_and_deployment
mailto:support@klocwork.com
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If you're using Insight version Apply this service release Then follow this upgrade path

8.0 8.0 SR3 8.0 SR3 --> 9.0 SR1 --> 9.6 SR4

8.1 8.1 SR1 Refresh 8.1 SR1 Refresh --> 9.1 GA --> 9.6 SR4

8.2 8.2 SR1 8.2 SR1 --> 9.2 SR3 --> 9.6 SR4

9.0 9.0 SR1 9.0 SR1 --> 9.6 SR4

9.1 None 9.1 --> 9.6 SR4

9.2 9.2 SR3 9.2 SR3 --> 9.6 SR4

9.5 9.5 SR1 9.5 SR1 --> 9.6 SR4

Important changes since Insight 8.0
To see what's new or changed in this release, see What's New and the Release Notes. If you are upgrading from one
of the older releases, also see What's New and the Release Notes from intervening versions so that you will
understand what changed.

Here's a list of the changes since Insight 8.0 that are most likely to affect you during and after upgrade:

Insight 8.1

It is no longer possible to create a project from C/C++ source root directories. C/C++ projects must be based on
one of the following:

Ä build specification
Ä Visual Studio project, solution or workspace
Ä existing tables

Creating a project from Java source root directories is still supported, but only for projects built in a non-Ant
environment.

See Integration build analysis for information on running the integration build analysis.

Insight 8.2

Ä Issue states are no longer displayed by the desktop analysis tools. Instead, issues introduced locally are identified
as "local", and issues identified in the integration build analysis are identified as "system". This makes it simpler
to locate and fix your own issues. See Origin (local or system).

Ä How issues are mapped between versions and builds: Depending on how many changes in the source code
have occurred, changes to line and column numbers, function signatures and function names are generally
handled successfully between versions and builds. For example, if only the line number is changed, the issue will
be propagated. If all of the above are changed, however, successful propagation will depend on how many similar
issues are reported on that same function. If the name of the file containing the reported issue changes, the issue
will not be migrated or propagated. In addition, changing the name of a variable can often affect migration and
propagation, due to the fact that the analysis engine needs to differentiate issues related to different variables. In
both these cases, the existing issue will be reported as "fixed", and a "new" issue will be reported.

Ä Possible changes in numbers of reported issues due to changes in how issues are grouped: Prior to Insight
8.2, it was possible to specify whether similar issues of the same type would be reported as one issue or multiple
issues. The KMC option "Group similar errors", which controlled this functionality, has been removed in version
8.2. In version 8.2, similar C/C++ issues of the same type will be reported as one issue. Similar Java issues of the
same type will be reported as multiple issues. This was the default behavior in previous versions of Klocwork. If
you had changed the default behavior in version 8.1 or earlier, you may see differences in the numbers of reported
issues once you run your first analysis with version 8.2 or later.

http://www.klocwork.com/products/documentation/dakota/index.php?title=What%27s_New
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes
http://www.klocwork.com/products/documentation/dakota/index.php?title=Integration_build_analysis
http://www.klocwork.com/products/documentation/dakota/index.php?title=Origin_%28local_or_system%29
http://www.klocwork.com/products/documentation/dakota/index.php?title=Propagation
http://www.klocwork.com/products/documentation/dakota/index.php?title=Migration
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Insight 9.0

Ä To enhance security when Basic, LDAP or NIS access control is configured, all users must now be
authenticated with the Klocwork Server. For GUI tools, a dialog will prompt users to log in; command-line tools
will prompt users to run a new command, kwauth. Each user needs to log in only once; a token is then stored in
the user's home directory. User passwords are not stored. See Setting up access control.

Ä When upgrading from versions earlier than 9.0, a new license is required to run Klocwork Insight.
Ä Continuous analysis: By default, the C/C++ plug-ins for Visual Studio and Eclipse as well as Klocwork Desktop

now run continuous analysis, checking for issues whenever you access or save a file, providing automatic defect
highlighting while you work in your editor.

Ä The Project Server and Web Server have been combined into one, called the Klocwork Server. Connected
desktops are now linked with the Klocwork Server instead of the Project Server.

Insight 9.1

Ä Reporting is now separate from build configuration.
Ä Issue categories are converted to taxonomies during migration, which may affect numbers of detected issues

after migration [1].
Ä It is no longer possible to load tables built with a previous version of Insight. Instead, you will need to

re-analyze the project by supplying a build specification to kwbuildproject.

Insight 9.2

Ä There is now only one Eclipse update site for both Java and C/C++. The installation option for both Unix and
Windows installers is now Eclipse.

Ä Administrator access is required to install all Windows packages.
Ä Performance changes required modifications to the MySQL database. A database integrity check is performed

during migration, so migration will take significantly longer than in previous releases.
Ä If Java 1.6 is not detected on your Windows machine, it will be installed with the Klocwork installation

packages.
Ä The compiler filter files (<compiler_name>_filter.xml) have been removed. These files no longer need

to be migrated. All compiler configuration is now contained in Python scripts, which are not editable. For all
compiler configuration issues, contact Customer Support [4]. See Adding an unsupported C/C++ compiler for
more information.

Insight 9.5

Ä There are now some differences in the way Insight data is migrated from a previous version:

Ä The way that issue severities and states are categorized is somewhat different, and will become apparent after
your first integration build analysis for a project. See Before your first 9.6 integration build analysis. If you
need a mapping of issue severities between version 9.5 and a previous version, contact Customer Support [4].

Ä The concept of "scopes" in Insight has been replaced by views. See Help - I'm used to scoping in Klocwork
Review.

Ä Some custom reports are treated differently. See Reporting for the integration build and Customizing metrics
reports in Klocwork Review.

Ä The concept of "components" in Insight has been replaced by modules. The modules.xml file is no longer
supported, and existing files are converted to modules during migration. Any modules that can't be converted
are reported in kwmigrate.log. See Organizing your code into modules.

Ä Three new roles exist in Insight 9.5: Build engineer, Developer and Manager, but the roles don't exist by
default for migrated projects_roots. See Enabling access to Klocwork projects.

Ä In Visual Studio, local defects aren't migrated from previous versions.
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Ä Support for 64-bit Java has been added for Windows and Linux. See the appropriate installation page.
Ä All administrative tasks have been moved from KMC to Klocwork Review, with many new web interface

features to make administration of projects and builds, users and roles easier. See Managing integration projects
and builds.

Ä Improvements to desktop analysis include:

Ä Support for the Eclipse plug-in on a 64-bit JVM for Windows and Linux.
Ä Support for the Klocwork Desktop Java Plug-in in IntelliJ IDEA 10 and 10.5. See Using Klocwork Desktop

Java Plug-in for IntelliJ IDEA.
Ä Klocwork Desktop support for Java projects in addition to C/C++. See Getting started with Klocwork Desktop

for Java.
Ä Added support for a number of C++11 language extensions. See Supported C/C++ language extensions [2].

Ä All users of Klocwork Visual Studio C/C++ and Eclipse C/c++ now have access to Klocwork Refactoring without
a separate license. See Klocwork Refactoring.

Ä Klocwork Inspect supports more SCMs. See Supported SCMs.
Ä There is added support for new C/C++ compilers. See Supported C/C++ compilers.

Interoperability between releases
Clients earlier than Klocwork Insight 9.6 cannot interoperate with a Klocwork Insight 9.6 Server. You must upgrade
both your Server and User installations to Klocwork Insight 9.6.

Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and set the
ports appropriately).

Handling licensing when using versions 8.x and 9.x
Versions 8.x and 9.x of Insight use two different license versions. However, it is possible to run both 8.x and 9.x
simultaneously. There are three scenarios in which you would want to run both versions:

If you want to... Then...

Set up a separate projects_root to test the new version Install Insight 9.6 in a new location and copy your new license file to the
<projects_root>/licenses directory in the new installation. Run a License
Server for each installation.

Upgrade your existing projects_root Append the contents of your new license file to the 8.x license file. Run only the License
Server from the 8.x installation. You can specify that version 9.6 should use the previous
License Server in one of two ways:

Ä During installation, by specifying the appropriate host and port in the wizard or with
the installation script. See Installing Klocwork Insight.

Ä After installation, with kwservice set-service-property. See Viewing and
changing Klocwork server settings.

Run separate production projects_roots for each version
(for example, if one group is upgrading but another
group needs to continue using version 8.x)

Install Insight 9.6 in a new location and copy your new license file to the
<projects_root>/licenses directory in the new installation. Run a License
Server for each installation.

Note: If you will use your organization's FLEXlm license server rather than the license server packaged with
Klocwork Insight, you must configure Insight and the FLEXlm license server to work together, and you must put
your Klocwork license file in the right place. See Using your organization's FLEXlm server.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Managing_integration_projects_and_builds
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http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_Klocwork_Desktop_for_Java
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http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_ports_used_by_the_Klocwork_servers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_ports_used_by_the_Klocwork_servers
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Prepare to upgrade
For details on starting and stopping the servers, see Starting the Klocwork Servers and Stopping the Klocwork
Servers.

To prepare to upgrade:

1. For the projects_root you wish to migrate, run:

kwservice --projects-root <projects_root> check 

2. Make note of what servers are running and what ports they are running on. After migration to the new version of
Klocwork Insight, the servers will be running on these ports.

3. Stop the servers.
4. To create a restore point, perform a complete backup of any projects_root directories you want to migrate. After

you upgrade Klocwork Insight, you cannot undo the upgrade. For information, see Backing up Klocwork data.
5. If you customized any configuration files (such as kwmysql.ini or kwfilter.conf), back up the
<server_install>/config directory.

6. Start the servers.
7. IMPORTANT: To reduce the time required to migrate your Klocwork data, Klocwork strongly recommends

that you:

Ä Delete any projects from the previous version that you do not need to migrate. See kwadmin delete-project.
Ä Delete any failed project builds from the previous version. You cannot resume a build that failed in a previous

release after migrating the project as described in this article. However, you may be able to load the build from
tables. See kwadmin delete-build.

8. If not running the Klocwork Servers as Windows services, stop the servers.
9. (Optional) To create a second restore point, back up the projects_root directories you have prepared for

migration.
10. Store the existing Klocwork license in a safe place.
11. To prevent confusion, delete the old Klocwork logs from <projects_root>/logs.

If you are using a separate MySQL database server
For Windows, Linux and Mac, the Database Server is a MySQL 5.1.68 database server. For Solaris and AIX, the
Database Server is a MySQL 5.1.66 database server. If you want to use your own manually installed MySQL
database server, it must be the appropriate version. If necessary, upgrade your separate MySQL database before you
install or upgrade Klocwork Insight.

Install the Insight Server package
Install the version 9.6 Server package. For instructions, see:

Ä Installing the Klocwork Server package on Windows -- Upgrade only
Ä Installing the Klocwork Server package on Unix -- Upgrade only
Ä Installing the Klocwork Server package on Mac -- Upgrade only

http://www.klocwork.com/products/documentation/dakota/index.php?title=Backing_up_Klocwork_data
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwadmin%23kwadmin_delete-project
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwadmin%23kwadmin_delete-build
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Validate your database (mandatory)
dbvalidate is a tool that checks the consistency of data in your database. It works on Insight versions 8.2 and later.
Running this tool is mandatory, so that any errors in your database can be corrected before you migrate.

Note: The Database Server from your old installation must be running to validate the database.

Run the following command:

java -jar <9.6_server_install>/class/dbvalidate.jar --db <host> --port <port> [--password <password>]

where

Ä <9.6_server_install> is your new installation directory
Ä <host> is the host name of the Database Server hosting the data you want to validate (default: localhost)
Ä <port> is the port number for the Database Server hosting the data you want to validate (default: 3306)
Ä <password> is the password for your database; specify this option only if a password was assigned

Examples

java -jar C:/Klocwork/class/dbvalidate.jar --db TITAN --port 3308 --password secret_password

java -jar C:/Klocwork/class/dbvalidate.jar --db TITAN --port 3308 

dbvalidate will report any errors between the "validation started" and "validation finished" lines:

Wed Jun 01 07:53:58 CDT 2011 kw_central database (version: 95) validation started

<detected errors appear here>

Wed Jun 01 07:54:28 CDT 2011 Database validation finished.

Ä If Errors are displayed, contact Klocwork Customer Support [4], so that we can correct the error prior to
migration.

Ä If no errors are displayed, your database was successfully validated.

Put your new license in the correct directory
If you received a new license file from Customer Support, copy it to <projects_root>/licenses.

Note: See Customizing licensing for information on licensing options.

Migrate your Klocwork data
To migrate a projects_root, run the following command from <Klocwork_9.6_Server_install>/bin:

kwservice --projects-root <old_projects_root> start --migrate

If the projects_root migrates successfully, the Klocwork Servers start on the port numbers picked up from the
migrated projects_root.

Notes:

Ä If you will be running the Klocwork Servers as Windows services, after starting the servers with the --migrate
option, stop the servers with kwservice --projects-root <migrated_projects_root> stop.
Then start the Insight 9.6 services in Windows Services Administration.

Ä You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands locally.

Ä The above command converts all external configuration files in the projects_root to UTF-8. As of Klocwork
Insight 8.1, all external configuration files must be UTF-8 encoded if they contain multibyte characters (for
example, Japanese). External configuration files are those listed in Configuration files you can edit.

mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Customizing_licensing
http://www.klocwork.com/products/documentation/dakota/index.php?title=Configuration_files_you_can_edit
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If you customized configuration or metrics files
Ä If you modified the MySQL configuration file located at
<old_Klocwork_install>/config/kwmysql.ini

Make the same changes to kwmysql.ini in the new installation.

Note: The following fields are no longer supported with the version of MySQL used with Insight 9.2 and later.
If your previous kwmysql.ini file contains these fields, do not copy these lines to the new file:

skip-bdb

myisam_max_extra_sort_file_size

Important: Do not copy your customized configuration files into the new Insight installation. Instead, make
the same customizations to the newly installed configuration files.

Ä If you modified the compiler mapping file located at
<old_Klocwork_install>/config/kwfilter.conf

Make the same changes to kwfilter.conf in the new installation.

Important: Do not copy your customized configuration files into the new Insight installation. Instead, make
the same customizations to the newly installed configuration files.

Ä The following files are obsolete as of Insight 9.5 and do not need to be migrated:

Ä the compiler configuration file (kwcc_config.xml)

See kwinject error - Compiler can't be configured for more information.
Ä compiler filter files (<compiler_name>_filter.xml)

You may need to contact Customer Support to replace your *_filter.xml file with a Python script. See
Adding an unsupported C/C++ compiler for details.

Ä If you added custom metrics reports to Klocwork Review, you need to edit the custom metrics report
configuration file (metrics.xml). Prior to Klocwork Insight 9.0, the metrics.xml file was located at:

<server_install>/webapps/review/reporting/config

Ä As of Klocwork Insight 9.0, the metrics.xml file is located at:

<projects root>/config

Notes

Ä As of Klocwork Insight 9.0, the metrics.xml file applies to a projects_root directory, not to an entire Klocwork
installation. Therefore, if you have multiple projects_root directories, you will need to copy your customized
metrics.xml file to each of your projects_roots.

Ä As of Klocwork Insight 9.0, you need to restart the Klocwork Server after customizing the metrics.xml file.

See Customizing metrics reports in Klocwork Review.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwinject_error_-_Compiler_can%27t_be_configured
http://www.klocwork.com/products/documentation/dakota/index.php?title=Adding_an_unsupported_C/C%2B%2B_compiler
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Test your upgrade
Ensure that you can see your projects and builds in Klocwork Review.

If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses is
correct.

Upgrade all client installations
Ensure that all Klocwork clients are upgraded to Insight 9.6. Clients earlier than Insight 9.6 cannot interoperate with
an Insight 9.6 Server.

Before installing a new version of the Klocwork User package, uninstall the previous version. For Windows, the
installation package will detect whether you have a previous version of the user package installed and automatically
uninstall it.

If users will be running the installation package themselves, tell them the host and port information for the Klocwork
Server and License Server, so that they can set it during installation.

See Installing Klocwork Insight for full information on installing the Klocwork User package.

Repeat upgrade steps on other projects_root directories
To migrate another projects_root, carry out the steps in this chapter again (except for installing Klocwork).

Summary of upgrade steps for second or later projects_root directory:

1. Prepare to upgrade.
2. Run:

kwservice --projects-root <projects_root> start --migrate

3. Re-create any compiler configuration files you had customized.
4. If you added custom metrics reports to Klocwork Review, edit the custom metrics report configuration file

(metrics.xml).
5. Test your upgrade.

Before your first version 9.6 integration build analysis
New releases of Insight normally have changes to the checker configuration to keep up with current events and
respond to customer requests. These changes may mean that your checker configuration from the previous release
isn't the same in the new release.

When you're migrating to a new release, the issues, status changes and comments from an analysis run in the
previous release are propagated only during the first run in the new release. If any checkers are disabled by default in
the new release, you can lose issues or status changes from the old analysis run, so it's important to run your first
analysis with the same configuration as before.

To do this, make sure that you that have the right checkers enabled to match your old configuration. See Disabled
C/C++ checkers in What's New, then make any changes to your checker configuration. After you're satisfied with
your configuration, perform your first version 9.6 integration build analysis on unmodified source code.

Note: If you've already run your first 9.6 analysis and you're missing some issues or status changes, delete that build,
reconfigure your checkers, and run a new analysis.

We recommend running your final pre-upgrade integration build analysis and your first version 9.6 analysis on
identical source code, and then comparing the two builds. This allows you to assess changes in the analysis engine.
For details on improved, added and removed checkers in this version, see What's New.
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Installing the Klocwork Server package on
Windows -- Upgrade only
<yambe:breadcrumb>Upgrading from a previous version|Upgrading</yambe:breadcrumb>This page provides
instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Before you begin
Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

Required permissions

Ä Administrator access is required to install all Windows packages, whether using the installation wizard or
unattended installation.

Ä You must have administrator access to install the Klocwork Server.
Ä You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as

Windows Services).
Ä For Windows Server 2008, you must use the 'Run As Administrator' option in order to launch any Klocwork tools

which access a projects_root that is located on a root directory.

Run the installation wizard
Run the Klocwork Server installation wizard, following the prompts. Note the following:

Ä The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will
install the appropriate version of Java.

Ä If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
Ä Caution: Do not install the Server package and the projects_root in the Program Files directory. Default security

settings for Windows 7 and Windows Server 2008 restrict writing to files in the Program Files directory.
Ä For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server

connection.
Ä When prompted for the location of the projects_root directory, specify the old projects_root directory that you

want to migrate.
Ä You do not need to set host names and port numbers for the Klocwork Servers during installation. This

information will be picked up from your old projects_root directory when it is migrated.
Ä Do not select the option to start the Klocwork Servers as Windows services automatically. You will start the

servers in a later step.
Ä The Klocwork bin directory (<server_install>\bin) is automatically added to your System Path

environment variable.
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Log files
An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows. For example, on Windows 7, the installation log file is saved to
\Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>-<package>.log. For example, the installation log
file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation. For the Server
installer, for example, the log files in this directory store kwservice output when the servers are first started and the
projects_root directory is initialized.

What's next?
Now it's time to validate your database.

References
[1] http:/ / developer. klocwork. com/ support/ public

Installing the Klocwork Server package on Unix
-- Upgrade only
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This page provides
instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Before you begin
Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

Installation notes

Ä Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that
matches your operating system.

Ä Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions:
chmod 755 <kw-installer.sh>

Ä To control permissions when you are installing Klocwork, change the value of umask.
Ä Install Klocwork software as a non-root user.
Ä If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the

installation program. Including the GCC compiler in your PATH automatically creates default links to standard
GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a
particular project or build by not including the standard libraries and defines. If your organization does not use
GCC, do not include it in your PATH when you run the installation program.

Ä Ensure that the path in which you install the product is the same path from which users invoke the product. For 
example, the local path to the installation might be /local/tools/klocwork, but users on other machines 
have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore, to ensure that users can

http://www.klocwork.com/products/documentation/dakota/index.php?title=Upgrading_from_a_previous_version%23Validate_your_database_%28mandatory%29
http://developer.klocwork.com/support/public
http://developer.klocwork.com/support/public
mailto:support@klocwork.com
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invoke the product, use the /opt/tools/klocwork path during installation.
Ä Important: Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special

file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL
documentation [1].

Run the installation package
Run the following command:

kw-server-installer-9.6.x.x.<platform>.sh -p <projects_root> [options] <install_directory> [component ...]

where

Ä <platform> is solaris, linux or aix
Ä <projects_root> is the location of the old projects_root directory that you want to migrate
Ä [<options>] are any of the options listed in Command-line options for the Server package

Note: You do not need to set host names and port numbers for the Klocwork Servers during installation. This
information will be picked up from your old projects_root directory when it is migrated.

Ä <install_directory> specifies the directory in which you want to install Klocwork. Do not specify a subdirectory
of the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with
the installation.

Ä [<component ...>] is any of the arguments from Arguments for Server components. Separate multiple components
with spaces. If you do not specify one or more components, the entire package will be installed. You can also see
a list of arguments for the various components with the --list option. Note that an asterisk in the returned output
means the component is already installed.

Example

kw-server-installer-9.6.0.0.linux.sh -p /space/old_projects_root /opt/klocwork

Command-line options for the Server package

Name Short
name

Description

--agree -a Agree to license terms and do not display license agreement.

--database-port
<port_number>

Specify the port number that you will use to run the Database Server. Default: 3306. This option is equivalent to
specifying the port number with kwservice.

--debug Print debug information

--force -f Install without integrity checks

--help -h Display this help and exit

--klocwork-port
<port_number>

Specify the port number that you will use to run the Klocwork Server. Default: 8080. This option is equivalent to
specifying the port number with kwservice.

--license-port
<port_number>

Specify that the License Server will be run locally, but on a non-default port. Default: 27000. This option is
equivalent to specifying the port number with kwservice.

--license-server
<host>[:<port>]

Specify a remote License Server host. The host argument is required; the port argument is optional. Default:
localhost:27000. This option is equivalent to specifying the host and port with kwservice. See also Using your
organization's FLEXlm server.

--list -l List available features (components)

http://dev.mysql.com/doc/refman/5.0/en/innodb-restrictions.html
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_your_organization%27s_FLEXlm_server
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_your_organization%27s_FLEXlm_server
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--projects-root
<directory>

-p Specify the complete path to a non-default projects_root directory. Default:
<install_directory>/projects_root.

The directory you specify must meet one of the following conditions:

Ä it does not yet exist
Ä it is empty
Ä it is a valid projects_root directory created previously

Do not specify the same directory as the root Klocwork installation directory you have specified. Do not install
Klocwork in a subdirectory of the projects_root directory.

IMPORTANT: If you are upgrading, specify the old projects_root directory that you want to migrate.

--use-ssl use a secure Klocwork server connection (HTTPS)

--version -v display the version of Klocwork software and exit

Arguments for Server components

To install this Server component (feature)... ...enter the argument...

Database Server DatabaseServer

License Server LicenseServer

Klocwork Server KlocworkServer

Administration and analysis management tools BuildTools

Add Klocwork to your PATH
On Unix, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

What's next?
Now it's time to validate your database.

References
[1] http:/ / dev. mysql. com/ doc/ refman/ 5. 0/ en/ innodb-restrictions. html

http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://www.klocwork.com/products/documentation/dakota/index.php?title=Upgrading_from_a_previous_version%23Validate_your_database_%28mandatory%29
http://dev.mysql.com/doc/refman/5.0/en/innodb-restrictions.html
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Installing the Klocwork Server package on Mac --
Upgrade only
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This page provides
instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Before you begin
Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

Prerequisites

Ä JVM versions: You must install JVM 1.6 Update 45 or later on your machine before installing the Klocwork
Server or User package. If you have a previous JVM version installed and you try to install the Server or User
package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java.
Use the Software Update feature on your Mac.

Ä Access level: When installing the Mac packages, you must have administrator access.
Ä If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the

installation program. Including the GCC compiler in your PATH automatically creates default links to standard
GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a
particular project or build by not including the standard libraries and defines. If your organization does not use
GCC, do not include it in your PATH when you run the installation program.

Running the installation package
Copy the Server installation package to your desktop and run it, following the prompts. Please note the following:

Ä All components of the Klocwork Server package are installed. You can't specify which components you want to
install.

Ä On the Server Settings screen, when prompted for the location of the projects_root, specify the old projects_root
directory that you want to migrate.

Ä You do not need to set host names and port numbers for the Klocwork Servers during installation. This
information will be picked up from your old projects_root directory when it is migrated.

http://developer.klocwork.com/support/public
mailto:support@klocwork.com
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Installation directories
Ä The Server package is installed in the /Applications/ and /Library/Frameworks/ directories.
Ä Access command-line tools using the symbolic links in /usr/local/kw/.

Troubleshooting
Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

What's next?
Now it's time to validate your database.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Upgrading_from_a_previous_version%23Validate_your_database_%28mandatory%29
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Installing the Server package

Installing Klocwork Insight

Before you install:ÅÅÅSystem requirementsÅÅÅ|ÅÅÅRelease NotesÅÅÅ|ÅÅÅAbout the Klocwork packages and components

Server installation

Ä Getting a license
Ä Installing the Klocwork Server package on Windows
Ä Installing the Klocwork Server package on Unix
Ä Installing the Klocwork Server package on Mac
Ä Viewing and changing Klocwork server settings

User/Client installation

Ä Installing the Klocwork User package on Windows
Ä Installing the Klocwork User package on Unix
Ä Installing the Klocwork User package on Mac

For Eclipse users:

Ä Install the Klocwork plug-in from the Eclipse update site

Upgrading

Ä Upgrading from a previous version
Ä Running a custom installation for new or upgraded IDEs
Ä Uninstalling Klocwork Insight

Additional installation topics

Ä Installing the Distributed Analysis package
Ä Unattended installation on Windows
Ä Testing your installation

Installation troubleshooting
Ä Error reading setup initialization file during installation
Ä Repairing a Windows installation of Klocwork Insight
Ä Find Klocwork Servers running on your LAN
Ä Unable to start the Database Server because the path to the socket file is too

long

Ä Unable to start Klocwork Servers following Windows
installation

Ä Database connection error
Ä Package Load Failure occurs in Visual Studio after I install

patch
Ä IntelliJ IDEA installation not detected; plugin not installed
Ä Limitations for installation

http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_a_license
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwdiscover
http://www.klocwork.com/products/documentation/dakota/index.php?title=Unable_to_start_the_Database_Server_because_the_path_to_the_socket_file_is_too_long
http://www.klocwork.com/products/documentation/dakota/index.php?title=Unable_to_start_the_Database_Server_because_the_path_to_the_socket_file_is_too_long
http://www.klocwork.com/products/documentation/dakota/index.php?title=Database_connection_error
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Limitations_for_installation%2C_upgrade_and_deployment
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Installing the Klocwork Server package on
Windows
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This page provides
instructions for installing the Klocwork Server package using the installation wizard. For instructions on unattended
installation of both the Klocwork Server and User packages, see Unattended installation on Windows.

You can either put the user packages where users can download and install them ("pull" installation) or, if your
organization is set up for it, you can install the clients for your users in an unattended ("push") installation through a
Software Management System (SMS) or similar system. In the "pull" scenario, you need to let your developers know
where they can access the User package.

Before you begin
Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don't already have one.

Running two versions of the Klocwork Servers
If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and set the
ports appropriately).

Required permissions

Ä Administrator access is required to install all Windows packages, whether using the installation wizard or
unattended installation.

Ä You must have administrator access to install the Klocwork Server.
Ä You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as

Windows Services).
Ä For Windows Server 2008, you must use the 'Run As Administrator' option in order to launch any Klocwork tools

which access a projects_root that is located on a root directory.

Installation using the Windows installation wizard
Run the Klocwork Server installation wizard, following the prompts. Note the following:

Ä The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will
install the appropriate version of Java.

Ä If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
Ä You can specify server information during installation in the Klocwork Servers configuration screen to override

the default settings. The defaults for the License Server are localhost and 27000. The default port for the
Klocwork Server is 8080. See Viewing and changing Klocwork server settings for more information on ports.

Ä For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server
connection.

Ä You'll be asked where you want to create the projects_root directory, which is the data location for the Klocwork 
Servers and applications. It contains Klocwork Server settings and information about integration projects and

http://developer.klocwork.com/support/public
mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_a_license
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_ports_used_by_the_Klocwork_servers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_ports_used_by_the_Klocwork_servers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
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build analysis runs. It also stores the Klocwork license file. The default location is
<server_install>\projects_root.

Caution: Do not install the Server package and the projects_root in the Program Files directory. Default
security settings for Windows 7 and Windows Server 2008 restrict writing to files in the Program Files
directory.

Ä During installation, you specify whether you want to use the locally installed License Server (Local) or connect to
a remote License Server (Remote). Local, the default option, requires you to browse to your license file. If you
select Remote, you must specify the host name and port number for your License Server.

Ä You have the option of starting the Klocwork Servers as Windows services automatically following installation.
This option is available on the Set up Klocwork Servers dialog of the Server package installer. If you do not select
this option, you need to start the servers manually following installation. See Start the servers below.

Note on the Path environment variable
On Windows, the Klocwork bin directory is automatically added to your Path environment variable as follows:

Installation package Environment variable modified Value used

Server System Path <server_install>/bin

User User Path <user_install>/bin

Log files for Windows installation
An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows. For example, on Windows 7, the installation log file is saved to
\Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>-<package>.log. For example, the installation log
file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation. For the Server
installer, for example, the log files in this directory store kwservice output when the servers are first started and the
projects_root directory is initialized.

Start the servers
If you did not already start the servers during installation, start them now, using Windows Services Administration or
kwservice start:

kwservice --projects-root <projects_root> start 

where <projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root C:\klocwork\projects_root start 

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_start
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Next steps
Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

Unattended installation on Windows
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This article covers unattended
installation of both the Server and User packages on Windows.

Installing in unattended mode
To run an unattended installation of Klocwork Insight, enter the following command:

 start /WAIT <installer.exe> /w /S [/L<langid>] /v"/qn INSTALLDIR=<install_directory> /log <install_log> PROPERTY=VALUE PROPERTY1=VALUE1..." 

where:

Ä <installer.exe> is the name of the installation package you want to use, for example,
kw-server-installer.9.6.0.0.windows.exe

Ä /w parameter will cause the parent process to wait for the installation process. See the InstallShield help library [1]

for more information on this.

Note: The %errorlevel% system variable can be used to check for installation success.

Ä /L<langid> allows you to change the default language for the installation package. By default, if your system
locale is Japanese, the installation package will run in Japanese. Otherwise, it will run in English. To specify
Japanese, use /L1041.

Ä /v passes subsequent parameters directly to the MSI engine. The entire string after /v must be surrounded by
quotation marks.

Ä /qn runs the installer in unattended mode
Ä <install_directory> is the absolute path to the directory in which you want to install Klocwork Insight. The default

is the root directory of the local drive with the most available space.
%LOCAL_DRIVE%\Klocwork\<package>, where <package> can be Server or User. Note that if the chosen
directory is not empty, you will not be able to continue with the installation.

Ä PROPERTY=VALUE is any of the Allowable PROPERTY=VALUE pairs for unattended installation

Note: Surround any value that contains spaces with escaped quotation marks (\").

Example

start /WAIT kw-server-installer.9.6.0.0.windows.exe /w /S /v"/qn INSTALLDIR=\"D:\Klocwork\Server 9.6\" /log C:\server.log"

http://www.klocwork.com/products/documentation/dakota/index.php?title=C/C%2B%2B_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=C-sharp_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=Java_integration_build_analysis_-_Cheat_sheet
http://kb.flexerasoftware.com/doc/Helpnet/installshield12helplib/IHelpSetup_EXECmdLine.htm#wp1021859
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Installing specific components in unattended mode
To install one or more specific Klocwork Insight components (for example, to install Klocwork Desktop C/C++
Plug-in for Visual Studio or Klocwork Architect) in an unattended installation, include
ADDLOCAL=<component_arguments> in your command line, where <component_arguments> is one or more
arguments from the following tables. Multiple arguments must be separated by commas.

To install this Server component (feature)... ...enter the argument...

Database Server DatabaseServer

License Server LicenseServer

Klocwork Server KlocworkServer

Administration and analysis management tools BuildTools

To install this User component (feature)... ...enter the argument...

Klocwork Architect Architect

Klocwork command line tools (for developers; includes Klocwork Desktop) CommandLineTools

Klocwork Desktop C/C++ Plug-in for Visual Studio .NET 2005 KC_VSNET2005

Klocwork Desktop C/C++ Plug-in for Visual Studio 2008 KC_VS2008

Klocwork Desktop C/C++ Plug-in for Visual Studio 2010 KC_VS2010

Klocwork Desktop Java or C/C++ Plug-in for Eclipse Eclipse

Klocwork Desktop Java Plug-in for IntelliJ IDEA KJ_IDEA

Allowable PROPERTY=VALUE pairs for unattended installation
Server package

PROPERTY=VALUE Description

ADDLOCAL=<component_list> Installs specific components only. See tables in previous section for allowable values for this
property.

INSTALLDIR=<install_directory> Install into the directory you specify. Default: current working directory. Note that if the chosen
directory is not empty, you will not be able to continue with the installation.

PROJECTS_ROOT=<projects_root_directory> Set up a projects_root directory in the directory you specify. The default is
<Server_install>/projects_root. Specify the complete path. IMPORTANT: If you
are upgrading, specify the old projects_root directory that you want to migrate.

LICENSE_HOST=<host_name> Specify License Server host name. Default: localhost

LICENSE_PORT=<port_number> Specify License Server port number. Default: 27000

MYSQL_HOST=<host_name> Specify Database Server host name. Default: localhost

MYSQL_PORT=<port_number> Specify Database Server port number. Default: 3306

KWSERVER_HOST=<host_name> Specify Klocwork Server host name. Default: localhost

KWSERVER_PORT=<port_number> Specify Klocwork Server port number. Default: 8080

USE_SSL=1 To use a secure Klocwork Server connection, set this value to 1. Default: 0

Note: The Server Installer also supports the ALLUSERS property. For details, see this MSDN article [2].

User package

http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://msdn.microsoft.com/en-us/library/aa371865(VS.85).aspx
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Name Description

ADDLOCAL=<component_arguments> Installs specific components only. See tables in previous section for allowable values for this property.

CREATE_SHORTCUTS=\"\" Suppress creation of desktop shortcuts. Default: 1 (create shortcuts)

IDEAINSTALLDIR= <directory> The directory where IntelliJ IDEA is installed

INSTALLDIR=<directory> Install into the directory you specify. Default: current working directory. Note that if the chosen directory
is not empty, you will not be able to continue with the installation.

LICENSE_HOST=<host_name> Use License Server running at <host_name>

LICENSE_PORT=<port_number> Use License Server running at <port_number>

KWSERVER_HOST=<host_name> Use Klocwork Server running at <host_name>

KWSERVER_PORT=<port_number> Use Klocwork Server running at <port_number>

USE_SSL=1 To use a secure Klocwork Server connection, set this value to 1. Default: 0

References
[1] http:/ / kb. flexerasoftware. com/ doc/ Helpnet/ installshield12helplib/ IHelpSetup_EXECmdLine. htm#wp1021859
[2] http:/ / msdn. microsoft. com/ en-us/ library/ aa371865(VS. 85). aspx

Installing the Klocwork Server package on Unix
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Before you begin
Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don't already have one.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 9.6 Servers while
users continue to access your existing servers, you must run them on different projects_root directories.

Check the system requirements

Refer to the System requirements for a list of required packages and dependencies.

Installation notes

Ä Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that
matches your operating system.

Ä Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions:
chmod 755 <kw-installer.sh>

Ä To control permissions when you are installing Klocwork, change the value of umask.
Ä Install Klocwork software as a non-root user.
Ä If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the

installation program. Including the GCC compiler in your PATH automatically creates default links to standard
GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a

http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://kb.flexerasoftware.com/doc/Helpnet/installshield12helplib/IHelpSetup_EXECmdLine.htm#wp1021859
http://msdn.microsoft.com/en-us/library/aa371865(VS.85).aspx
http://developer.klocwork.com/support/public
mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_a_license
http://www.klocwork.com/products/documentation/dakota/index.php?title=System_requirements%23Operating_system_patches_and_packages
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particular project or build by not including the standard libraries and defines. If your organization does not use
GCC, do not include it in your PATH when you run the installation program.

Ä Ensure that the path in which you install the product is the same path from which users invoke the product. For
example, the local path to the installation might be /local/tools/klocwork, but users on other machines
have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore, to ensure that users can
invoke the product, use the /opt/tools/klocwork path during installation.

Ä Important: Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special
file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL
documentation [1].

Running the installation package
Run the following command:

kw-server-installer-9.6.x.x.<platform>.sh [options] <install_directory> [component ...]

where

Ä <platform> is solaris, linux or aix
Ä [<options>] are any of the options listed in Command-line options for the Server package.
Ä <install_directory> specifies the directory in which you want to install Klocwork. Do not specify a subdirectory

of the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with
the installation.

Ä [<component ...>] is any of the arguments from Arguments for Server components. Separate multiple components
with spaces. If you do not specify one or more components, the entire package will be installed. You can also see
a list of arguments for the various components with the --list option. Note that an asterisk in the returned output
means the component is already installed.

Example: Installing only the Database Server component on Linux

kw-server-installer-9.6.0.0.linux.sh -p /space/projects_root /opt/klocwork DatabaseServer

where

Ä /space/projects_root specifies the projects_root location. The default is
<Server_install>/projects_root. For more information, see About the projects_root directory.

Ä /opt/klocwork specifies the directory in which you want to install the Database Server
Ä DatabaseServer indicates that only the Database Server component is to be installed

Command-line options for the Server package

http://dev.mysql.com/doc/refman/5.0/en/innodb-restrictions.html
http://www.klocwork.com/products/documentation/dakota/index.php?title=About_the_Klocwork_packages_and_components%23About_the_projects_root_directory
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Name Short
name

Description

--agree -a Agree to license terms and do not display license agreement.

--database-port
<port_number>

Specify the port number that you will use to run the Database Server. Default: 3306. This option is equivalent to
specifying the port number with kwservice.

--debug Print debug information

--force -f Install without integrity checks

--help -h Display this help and exit

--klocwork-port
<port_number>

Specify the port number that you will use to run the Klocwork Server. Default: 8080. This option is equivalent to
specifying the port number with kwservice.

--license-port
<port_number>

Specify that the License Server will be run locally, but on a non-default port. Default: 27000. This option is
equivalent to specifying the port number with kwservice.

--license-server
<host>[:<port>]

Specify a remote License Server host. The host argument is required; the port argument is optional. Default:
localhost:27000. This option is equivalent to specifying the host and port with kwservice. See also Using your
organization's FLEXlm server.

--list -l List available features (components)

--projects-root
<directory>

-p Specify the complete path to a non-default projects_root directory. Default:
<install_directory>/projects_root.

The directory you specify must meet one of the following conditions:

Ä it does not yet exist
Ä it is empty
Ä it is a valid projects_root directory created previously

Do not specify the same directory as the root Klocwork installation directory you have specified. Do not install
Klocwork in a subdirectory of the projects_root directory.

IMPORTANT: If you are upgrading, specify the old projects_root directory that you want to migrate.

--use-ssl use a secure Klocwork server connection (HTTPS)

--version -v display the version of Klocwork software and exit

Arguments for Server components

To install this Server component (feature)... ...enter the argument...

Database Server DatabaseServer

License Server LicenseServer

Klocwork Server KlocworkServer

Administration and analysis management tools BuildTools

http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_your_organization%27s_FLEXlm_server
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_your_organization%27s_FLEXlm_server
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
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Add Klocwork to your PATH
On Unix, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

Copy the license file
Copy your license file to the following location:

<projects_root>/licenses

The license file must have the extension .lic.

Note: See Customizing licensing for licensing options such as using your organization's license server.

Start the servers
Start the servers with kwservice start:

kwservice --projects-root <projects_root> start 

where <projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root /space/klocwork/projects_root start 

You see messages indicating that the servers have been started, showing the server host name and port number and
the path to the projects_root. For example:

Using projects root: /space/klocwork/projects_root

Local Host is: serverxyz.com [13.1.1.142]

Starting License Server [started on serverxyz.com:27000] (projects

root is /space/klocwork/projects_root)

Starting Database Server [started on serverxyz.com:3306] (projects

root is /space/klocwork/projects_root)

Starting Klocwork Server [started on serverxyz.com:8080] (projects

root is /space/klocwork/projects_root)

Important: If you create a script to start the Klocwork servers automatically, do not name your script 'klocwork' as
it will interfere with existing processes.

Next steps
Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

http://www.klocwork.com/products/documentation/dakota/index.php?title=Customizing_licensing
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_start
http://www.klocwork.com/products/documentation/dakota/index.php?title=C/C%2B%2B_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=C-sharp_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=Java_integration_build_analysis_-_Cheat_sheet
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Installing the Klocwork Server package on Mac
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This page provides
instructions for installing the Klocwork Server package using the installer.

Before you begin
Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support [1]. Typically, only one or two users in an organization have access
to my.klocwork. If you don't have access, contact Klocwork Customer Support [4].

You need a license. See Getting a license if you don't already have one.

Prerequisites
Ä JVM versions: You must install JVM 1.6 Update 45 or later on your machine before installing the Klocwork

Server or User package. If you have a previous JVM version installed and you try to install the Server or User
package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java.
Use the Software Update feature on your Mac.

Ä Access level: When installing the Mac packages, you must have administrator access.
Ä If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the

installation program. Including the GCC compiler in your PATH automatically creates default links to standard
GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a
particular project or build by not including the standard libraries and defines. If your organization does not use
GCC, do not include it in your PATH when you run the installation program.

Default settings and installation directories
Ä The Klocwork Server and User packages are installed in the /Applications/ and
/Library/Frameworks/ directories.

Ä Access command-line tools using the symbolic links in /usr/local/kw/.
Ä The projects_root directory installs to /Users/Shared/Klocwork/projects_root/ by default.
Ä The Klocwork Servers are set to localhost, running on the default ports.

You can override server settings and specify where the projects_root is created during installation.

Note: All components of the Klocwork Server and User packages are installed. You can't specify which components
you want to install.

Running the installation package
Copy the Klocwork Server installation package to your desktop and run it, following the prompts. Please note the
following:

Ä The Server Settings screen is where you can adjust:

Ä the location of the projects_root directory
Ä ports for the Klocwork and Database Servers

Ä During installation, you specify whether you want to use the locally installed License Server (Local) or connect to
a remote License Server (Remote). Local, the default option, requires you to browse to your license file. If you
select Remote, you must specify the host name and port number for your License Server.

http://developer.klocwork.com/support/public
mailto:support@klocwork.com
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_a_license
http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_ports_used_by_the_Klocwork_Servers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
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Troubleshooting
Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

Start the servers
Start the servers with kwservice start:

kwservice --projects-root <projects_root> start 

where <projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root /space/klocwork/projects_root start 

You see messages indicating that the servers have been started, showing the server host name and port number and
the path to the projects_root. For example:

Using projects root: /space/klocwork/projects_root

Local Host is: serverxyz.com [13.1.1.142]

Starting License Server [started on serverxyz.com:27000] (projects

root is /space/klocwork/projects_root)

Starting Database Server [started on serverxyz.com:3306] (projects

root is /space/klocwork/projects_root)

Starting Klocwork Server [started on serverxyz.com:8080] (projects

root is /space/klocwork/projects_root)

Next steps
Now you're ready to analyze your integration build.

Details: C/C++ | C# | Java

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_start
http://www.klocwork.com/products/documentation/dakota/index.php?title=C/C%2B%2B_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=C-sharp_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=Java_integration_build_analysis_-_Cheat_sheet
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kwupdate
<yambe:breadcrumb self="kwupdate">Command_Reference|Command reference</yambe:breadcrumb>The
kwupdate command for Unix lists installed components and installs/uninstalls patches.

Note: If you did not install a particular component with the installation package, it's not possible to install that
component later with kwupdate. In order to install another component of the Klocwork tools, you must re-run the
appropriate Server or User installation package.

Synopsis

List installed patches
kwupdate [<options>] --list-updates

List installed components
kwupdate [<options>] --list

Install a previously uninstalled patch
You normally install a patch by running a self-extracting patch installer script, for example,
RP9.5.0.XXXX-linux-9.5.0.YYYY.sh. You would only run the following command to install a previously
uninstalled patch.

kwupdate [<options>] --install --sequence <patch_number> ALL

where

Ä <options> are any of the options from the table below
Ä <patch_number> is the number of the patch you want to reinstall
Ä ALL means apply the patch to all installed components

Example

kwupdate --install --sequence 11269 ALL

Uninstall a patch
kwupdate [<options>] --uninstall --sequence <patch_number> ALL

where

Ä <options> are any of the options from the table below
Ä <patch_number> is the number of the patch you want to uninstall
Ä ALL means uninstall the patch from all installed components

Example

kwupdate --uninstall --sequence 11269 ALL
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Options

Name Short
name

Description 

--config <file> -C use this configuration file (default is KW-HOME/etc/kwupdate.conf)

--define
<name>=<value>

-D define a variable with the specified value. Some packages use variables to keep track of important information.
For example, the IntelliJ IDEA plugin requires the "idea.home" variable to be set to the IntelliJ IDEA home
directory.

--help -h print this help and exit

--idea-dir <dir> IntelliJ IDEA home directory. Equivalent to --define idea.home=<dir>

--install -i install previously uninstalled patches. Use --sequence to specify patch numbers.

--list -l list installed components

--list-updates list installed updates

--no-saved-variables -N do not use or update remembered variable values. Normally, when a variable is set, its value is saved in the
kwupdate database, so that you do not have to re-type the same variables. This option instructs kwupdate to ignore
saved variable values and not to update the kwupdate internal database with new variable values.

--quiet -q print as little as possible (only errors and warnings)

--sequence <num> -n specify update sequence number (use with --install, --uninstall). Separate multiple patch numbers with spaces.

--uninstall -u remove installed patch(es). Use --sequence to specify patch numbers.

--version -v print version and exit
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Installing the User package

Installing the Klocwork User package on
Windows
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> This article provides
instructions on using the installation wizard. For unattended installation, see Unattended installation on Windows.

Before you begin
Ä The installation package will detect whether you have a previous version of the user package installed and

automatically uninstall it.
Ä By default, the Klocwork User package will install for all users on a single machine.
Ä You can only have one installation the Klocwork User package on a machine (regardless of the version). If you

run the Klocwork User package again, the installation wizard will ask you if you want to remove or modify the
previous installation.

Ä You can specify information for the Klocwork Servers during installation in the Klocwork Servers configuration
screen to override the default settings. The defaults for the License Server are localhost and 27000. The default
port for the Klocwork Server is 8080.

Ä You must have administrator access to your machine to install the Klocwork User package.

For limitations related to installation, see the Release Notes.

Running the installation wizard
The Windows Klocwork User package is called kw-user-installer.9.6.x.x.windows.exe. For more
information about the components, see About the Klocwork packages and components.

Ä If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
Ä The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will

install the appropriate version of Java.
Ä Destination Directory screen: The default destination directory is the local drive with the most available space.

For example:

D:\Klocwork\User 9.6\

Ä Change Current Destination Directory screen: Important: Avoid installing the package in the Program Files
directory on Windows Vista, Windows Server 2008 and Windows 7 machines. Windows User Access Control
(UAC) restricts writing to the Program Files directory.

Ä Klocwork Servers configuration screen: Specify the Klocwork Server information provided by your Klocwork
administrator. Select Use secure server connection (HTTPS) if a secure Klocwork Server connection has been
configured.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Installing_the_Klocwork_Server_package_on_Windows%23Unattended_installation_on_Windows
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes
http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
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Troubleshooting
Ä If you have trouble installing the IntelliJ IDEA plugin, see IntelliJ IDEA installation not detected; plugin not

installed.
Ä See also the main Troubleshooting page.

What's next?
Ä Eclipse users need to install the Klocwork plug-in from the Eclipse update site.
Ä Go to Fixing issues before check-in with Klocwork Desktop Analysis and choose your development environment.

Installing the Klocwork User package on Unix
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Before you begin
Ä Before installing a new version of the Klocwork User package, uninstall the previous version.
Ä Check the System requirements.
Ä To control permissions when you are installing Klocwork Insight, change the value of umask.
Ä To change the permissions on an existing installation, use chmod.
Ä Install Klocwork software as a non-root user.
Ä Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one that

matches your operating system.

Installing Klocwork User on Unix
Run the following command:

kw-user-installer-9.6.x.x.<platform>.sh [options] <install_directory> [component ...]

where

Ä <platform> is either solaris or linux or linux64 if you are using 64-bit linux
Ä [<options>] are any of the options listed in Command-line options for the User package on Unix.

Note: If you want to install the Klocwork Desktop Java Plug-in for IntelliJ IDEA, you must use the --idea-dir
option.

Ä <install_directory> specifies the directory in which you want to install Klocwork Insight. Note that if the chosen
directory is not empty, you will not be able to continue with the installation.

Ä [component ...] is any of the arguments from Arguments for User components on Unix. Separate multiple
components with spaces. If you do not specify one or more components, the entire package will be installed. You
can also see a list of arguments for the various components with the --list option. Note that an asterisk in the
returned output means the component is already installed.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Troubleshooting
http://www.klocwork.com/products/documentation/dakota/index.php?title=Fixing_issues_before_check-in_with_Klocwork_Desktop_Analysis
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Example 1: Installing the entire Klocwork User package on Solaris
kw-user-installer-9.6.1.1.solaris.sh -a /home/jlee/klocwork

where

Ä -a means that you agree to the terms of the Klocwork license
Ä /home/jlee/klocwork specifies where Klocwork Insight will be installed

Example 2: Installing the Command Line Tools component on Linux
kw-user-installer.9.6.1.1.linux64.sh -a /home/jlee/klocwork CommandLineTools

The example above uses:

Ä -a to agree to the license without displaying the license agreement
Ä /home/jlee/klocwork specifies where Klocwork Insight will be installed
Ä CommandLineTools argument to install only the command-line feature from the User package.

Tip: You can specify the Klocwork Server (if you will be connecting to a server project) or the License Server (for
standalone projects) during installation by using the appropriate Unix installer command-line options.

Example 3: Installing Klocwork Desktop Plug-in for Eclipse on Linux
kw-user-installer-9.6.1.1.linux64.sh -a /home/jlee/ ECLIPSE

where

Ä -a means that you agree to the terms of the Klocwork license
Ä /home/jlee/Klocwork specifies where Klocwork Insight will be installed
Ä ECLIPSE indicates that only Klocwork for Eclipse feature is to be installed

Example 4: Installing Klocwork Desktop Plug-in for IntelliJ IDEA on Linux
kw-user-installer-9.6.1.1.linux64.sh -a --idea-dir "/home/jlee/JetBrains/IntelliJ IDEA 9.0" "/opt/klocwork/user 9.6" KJ_IDEA

where

Ä -a means that you agree to the terms of the Klocwork license
Ä "/home/jlee/JetBrains/IntelliJ IDEA 9.0" specifies where IntelliJ IDEA is installed on your

machine
Ä "/opt/klocwork/user 9.6" is the path to the Klocwork user install directory
Ä KJ_IDEA indicates that only the Klocwork Desktop Java Plug-in for IntelliJ IDEA is to be installed

Command-line options for the User package on Unix
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Name Short
name

Description

--agree -a agree to license terms and do not display license agreement

--force -f install without integrity checks

--help -h display this help and exit

--idea-dir specify the directory where IntelliJ IDEA is installed (applicable only if you are installing Klocwork
Insight Java Plug-in for IntelliJ IDEA)

--klocwork-server
<host>[:<port>]

specify the Klocwork Server host name and port number. Default: localhost:8080.

--license-server
<host>[:<port>]

specify the License Server host name and port number. Default: localhost:27000

--list -l list available features (components)

--use-ssl use a secure Klocwork Server connection

--version -v display the version of Klocwork software and exit

Arguments for User components on Unix

To install this User component (feature)... ...enter the argument...

Klocwork Architect Architect

Klocwork command line tools (for developers) CommandLineTools

Klocwork for Eclipse ECLIPSE

Klocwork for Java in IntelliJ IDEA (Linux only) KJ_IDEA

Add the bin directory to your PATH
We recommend adding the <user_install>/bin directory to your PATH environment variable. Procedures in
the documentation assume that you have added the bin directory to your PATH.

Troubleshooting
Ä Package Load Failure occurs in Visual Studio after I install patch
Ä IntelliJ IDEA installation not detected; plugin not installed
Ä Error reading setup initialization file during installation

What's next?
Ä Eclipse users need to install the Klocwork plug-in from the Eclipse update site.
Ä Go to Fixing issues before check-in with Klocwork Desktop Analysis and choose your development environment.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_a_secure_Klocwork_Server_connection
http://www.klocwork.com/products/documentation/dakota/index.php?title=Fixing_issues_before_check-in_with_Klocwork_Desktop_Analysis
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Installing the Klocwork User package on Mac
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Before you begin
Typically, the Klocwork administrator makes the User package available to developers in a centralized tools
directory. If you're not sure where the package is located, ask the administrator.

Before installing a new version of the Klocwork User package, uninstall the previous version.

Prerequisites
Ä JVM version: You must install JVM 1.6 Update 45 or later on your machine before installing the Klocwork

Server or User package. If you have a previous JVM version installed and you try to install the Server or User
package, you will see the error message, "Version of Java is too old". Apple supplies their own version of Java.
Use the Software Update feature on your Mac.

Ä Access level: When installing the Mac packages, you must have administrator access.

Using the installer GUI
To install, simply copy the installation package to your desktop and run it, following the prompts.

Notes:

Ä The User package installs in the following directories:

Ä /Applications/Klocwork User 9.6/

Ä /Library/Frameworks/KlocworkUser.framework/Versions/9.6/

Ä All applications in the User package are installed. You can't do a custom installation.
Ä Access command-line tools using the symbolic links in /usr/local/kw/.

What's next?
Ä If you're an Eclipse user, install the Klocwork plug-in from the Eclipse update site.

Ä If you're an intelliJ IDEA user, see Getting started with Klocwork Desktop Java Plug-in for IntelliJ IDEA.

Ä If you're using an IDE or editor not supported with a Klocwork plug-in, see Getting started with kwcheck for
Java.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_Klocwork_Desktop_Java_Plug-in_for_IntelliJ_IDEA
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_kwcheck_for_Java
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_kwcheck_for_Java


Installing the Klocwork plug-in from the Eclipse update site 44

Installing the Klocwork plug-in from the Eclipse
update site
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>If you installed the Klocwork
plug-in for Eclipse from the Klocwork User package, you also need to install the Eclipse update site and specify the
path to the Klocwork installation directory in Eclipse.

Install the update site in Eclipse
Follow the instructions according to the version of Eclipse you're using:

Eclipse 3.4 Eclipse 3.5, 3.6, 3.7 and 4.2

1. In Eclipse, go to Help > Software
Updates.
2. Click the Available Software tab.
3. Click Add Site and then click Archive.

1. In Eclipse, go to Help > Install New
Software.
2. Click Add.
3. Click Archive.

Wind River Workbench: Select the Advanced Device Development perspective (the button near the upper
right) to access Help > Software Updates.

4. Navigate to <user_install>/update-site/kw-eclipse-update-site.zip.

Tip: On Mac, Klocwork is installed at
/Library/Frameworks/KlocworkUser.framework/Versions/9.6/.

5. Click Open.

6. Click OK.

The update site is added to the list of sites to search.

Next, install the update site:

Eclipse 3.4 Eclipse 3.5, 3.6, 3.7 and 4.2

1. Click Install.
2. Click Finish.
3. When you are prompted to
restart Eclipse, click Yes.

1. Add a check to Static Analysis Tools if you want to install both Klocwork for C/C++ and Klocwork for Java.
Otherwise expand Static Analysis Tools and add a check to your preferred language. Then click Next.
Note: Install the plug-in that reflects the language of your installed development tools. For example, if you are
only using JDT, then only install Klocwork for Java.
2. In Install Details, click Finish.
3. When you are prompted to restart Eclipse, click Yes.

Specify the path to the user installation directory
1. Go to Window > Preferences.
2. Expand Klocwork and click Settings.
3. Click the Browse button next to Path to User Klocwork installation and browse to the Klocwork User installation

directory. For example:

D:\Klocwork\User 9.6

Tip: On Mac, Klocwork is installed at
/Library/Frameworks/KlocworkUser.framework/Versions/9.6/.

4. Click OK.
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What's next?
To get started with a Klocwork desktop analysis, go to one of the following:

Ä Getting started with Klocwork Desktop C/C++ Plug-in for Eclipse
Ä Getting started with Klocwork Desktop Java Plug-in for Eclipse

Running a custom installation for new or
upgraded IDEs
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>If, after you installed Klocwork
Insight, you upgraded your IDE, you must uninstall the previous version of the plug-in. For uninstallation
information, see Uninstalling Klocwork Insight.

After uninstalling, either:

Ä re-run the Klocwork User installer and selectively install the plug-in version that you need (for example, if you've
gone from Visual Studio 2005 to 2010), or

Ä install the update site from the <user_install>/update-site directory and set the path to your
installation directory in your new version of Eclipse

If you're using Klocwork Desktop Command Line or Klocwork Desktop, you don't have to do anything further.

Upgrade steps are provided below, by IDE plug-in.

Visual Studio
Just re-run the Klocwork User package installer on Windows. The installer automatically detects installed versions
of Visual Studio on your machine.

Deselect features you don't want installed.

Eclipse
Regardless of the Eclipse version you upgraded to, you need to:

1. Install the Klocwork plug-in from the Eclipse update site.
2. Specify the path to the user installation directory.

IntelliJ IDEA
If you installed the upgraded version of IntelliJ IDEA in the same directory, you don't need to do anything further.

If you installed IDEA to a different location:

Ä Windows:

Re-run the Windows installer and deselect features you don't want installed on your machine.

During installation, Klocwork Insight automatically detects your IntelliJ IDEA directory and installs the
plug-in directory to that location. If more than one IDEA installation directory is detected, you have to browse
to the preferred location.

Ä Linux:

Run the following command:

<kw-user-installer> --idea-dir <intellij_install_location> <user_install> KJ_IDEA

http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_Klocwork_Desktop_C/C%2B%2B_Plug-in_for_Eclipse
http://www.klocwork.com/products/documentation/dakota/index.php?title=Getting_started_with_Klocwork_Desktop_Java_Plug-in_for_Eclipse
http://www.klocwork.com/products/documentation/dakota/index.php?title=Installing_the_Klocwork_plug-in_from_the_Eclipse_update_site%23Specify_the_path_to_the_user_installation_directory
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where

Ä <kw-user-installer> is the name of the Klocwork installer executable
Ä <intellij_install_location> specifies where IntelliJ IDEA is installed on your system
Ä <user_install> is the directory where you want to install Klocwork. Note that if the chosen directory is not

empty, you will not be able to continue with the installation.
Ä KJ_IDEA specifies that only the IntelliJ IDEA plug-in will be installed

Example:

kw-user-installer.9.x.x.x.linux.sh --idea-dir jlee/JetBrains/IntelliJIDEA /home/jlee/Klocwork KJ_IDEA
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Installing the Distributed Analysis package

Installing the Distributed Analysis package
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> The Distributed Analysis
components are available as a separate Klocwork installation package (for example, on Linux, the package is
kw-dist-build-installer.9.x.x.xx.linux.sh).

Installing on Unix
To install the complete Klocwork Distributed Analysis package on Unix:

1. Download the Klocwork Distributed Analysis installation package for your operating system to a temporary
directory.

2. Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate
permissions. Enter:

chmod 755 <executable-name>

Note: Install Klocwork software as a non-root user.
3. Run the executable with the options and arguments you want.

<kw-dist-analysis-installer> -a -i <install_directory>

where:

<kw-dist-analysis-installer> is the name of the installation executable

-a indicates that you accept the license agreement

<install_directory> is the absolute path to the location in which you want to install the Distributed Analysis
package

Installing on Windows
On Windows, you can use the installation wizard or perform an unattended installation.

To install the Klocwork Distributed Analysis package on Windows, you must have administrator permissions for the
machine you want to install on.

Note: The Klocwork User package automatically installs for all users on a single machine.

Installing Klocwork with the installation wizard
To install the Klocwork Insight Distributed Analysis package or its components on a local machine:

1. Download the Klocwork Distributed Analysis package for Windows to a temporary directory.
2. Run the installation executable.

The graphical user interface initializes and prepares.

The Welcome screen of the wizard appears.
3. Click Next.

The License Agreement screen appears.
4. Review the license agreement, and, if you agree, click "I accept the terms of the license agreement".
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5. Click Next.

The "Destination Directory" screen appears.

The default destination directory is the local drive with the most available space. For example:

D:\Klocwork\Distributed Analysis 9.6\

6. Click Next to accept the default folder or click Change... to install Klocwork in a different location.

If you click Change..., the Change Current Destination Folder screen appears. Browse to the folder where you
want to install Klocwork.

Important: Avoid installing the package in the Program Files directory on Windows Vista, Windows Server
2008 and Windows 7 machines. Windows User Access Control (UAC) restricts writing to the Program Files
directory.

7. Click OK.
8. Click Next.

The Setup Type screen appears.

By default, the Complete button is selected.
9. To install the entire Klocwork Distributed Analysis package on one machine, leave the Complete button selected

and go to step 11.

To select one component to install on this machine, click Custom and click Next.

The Custom Setup screen appears, showing two choices.

Note: In the Windows installation wizard, the term "feature" means "component".

If there is a component you do not want to install on this machine, click the icon of the component and click
This feature will not be available. Any components you do not disable will be installed. Click off Klocwork
Distributed Analysis Server or Klocwork Distributed Analysis Agent, depending on which component you
do not wish to install.

Important: Ensure that you choose a location with enough disk space. See System requirements. To see how
much disk space is available on the machine, click Space.

10. Click Next.

The Ready to Install the Program screen appears.
11. To review or change any of your installation settings, click Back. To continue the installation with the settings

you have, click Install.

A progress bar appears while Klocwork installs.

The Setup Wizard Completed screen appears.
12. Click Finish.

Running an unattended installation on Windows
To run an unattended Windows installation of the Distributed Analysis package, enter the following command:

<kw-dist-build-installer> /S/v"/qn [ADDLOCAL=<component_code>] INSTALLDIR=<install_directory> /lv* <log_file>"

where:

Ä <kw-dist-build-installer> is the name of the Windows Distributed Analysis installation executable
Ä ADDLOCAL=<component_code> is optional and allows you to install only the Server or the Agent component

of the package
Ä <component_code> is either DistributedAnalysisServer or DistributedAnalysisAgent
Ä <install_directory> is the absolute path to the directory in which you want to install
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Ä /lv* <log_file> allows you to log installation errors to file (recommended). The directory you specify must
already exist. Use the absolute path to the log file.

Note: Surround any value that contains spaces with escaped quotation marks (\").

Example:

kw-dist-build-installer.9.5.0.0.windows.exe /S /v"/qn 

INSTALLDIR=\"C:\Klocwork\9.5.0.0\Distributed Analysis\" 

<br/>/lvx* C:\Klocwork\dist_analysis.log"

Log files for Windows installation
An installation log file is saved to %USERPROFILE%\Local Settings\Temp whenever one of the Klocwork
installation packages is started on Windows.

These log files are named Klocwork<release-number>-<package>.log. For example, the installation log
file for the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation on Windows. For the
Server installer, for example, the log files in this directory store kwservice output when the servers are first started
and the projects_root directory is initialized.

If you need to troubleshoot your installation, check these logs.

What's next?
Now it's time to Integrate Klocwork with your build.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Using_kwwrap_plus_kwinject_to_generate_a_build_specification
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Configuring and starting the Klocwork
servers

Viewing and changing Klocwork server settings
<yambe:breadcrumb>Server and database administration|Server and database admin</yambe:breadcrumb>Note: If
the Klocwork Servers are running, you must stop them before attempting to change service properties. See Stopping
the Klocwork Servers.

Viewing server settings
To view the host and port settings for the Klocwork Servers, use the command kwservice get-service-properties (this
does not use a Klocwork license).

Setting the host name of the Klocwork Servers
If you have installed the Klocwork Servers in a central location and will be running one or more of the servers from
another host machine, you will need to set the host name for these servers.

IMPORTANT NOTES:

Ä When issuing server configuration commands, the projects_root must be visible from the machine you're logged
into.

Ä If you specify a different host for one or more Klocwork Servers using the procedure below, you will no longer be
able to start the servers from the host where you previously started them.

Ä If the server hosts are located on a different subnet from the Klocwork clients, you must use the fully qualified
host name for the Klocwork Servers in the procedure below. Otherwise, the clients will not be able to connect to
the servers.

Ä You cannot change the physical host of the Klocwork License Server in the license file. If you need to move the
License Server to another host, you must contact Klocwork for a new license file. However, you can use the
procedure below if the name of the machine hosting the License Server has changed, or if you want to change
how the host name is defined (for example, from a simple to a fully qualified host name). The host name in the
license file must match the host name specified with the procedure below.

Ä If you have set up redundant License Servers, ensure that you specify the host name of the master License Server.
Ä See also Making network changes that affect the host name or IP address of a host machine.

To set the host name for one of the Klocwork Servers:

1. Stop the server, if is running. See Stopping the Klocwork Servers.
2. Run the following command:

kwservice --projects-root <projects_root> set-service-property <server_name> host <host_name> 

where

Ä <projects_root> is the projects_root directory you want to use
Ä <server_name> is one of:

Ä database
Ä license

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_get-service-properties
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Making_network_changes_that_affect_the_host_name_or_IP_address_of_a_host_machine
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Ä klocwork
Ä <host_name> is the name of the machine that will host the specified server (Klocwork recommends using the

fully qualified host name; see "Important Notes" above).

Example:

kwservice --projects-root C:\Klocwork\projects_root set-service-property database host server0196.acme.com 

3. Start the server. See Starting the Klocwork Servers.

Setting the ports used by the Klocwork Servers
The following table shows the default port numbers for a new installation of the Klocwork Servers.

Default port numbers

Server name Port

Database Server 3306

License Server 27000 plus 33133

Klocwork Server 8080 plus 8081

Important:

Ä If you migrated from a previous version of Klocwork, your servers will be running on the ports stored in the old
projects_root.

Ä Each Klocwork Server must run on a dedicated port. Do not set any other application to use the same port
numbers.

Ä The Klocwork Server uses two consecutive ports (the one you choose, plus the next one).
Ä The default port for each server is the typical port for that type of server (for example, port 3306 is the typical port

for a MySQL server), so if you will be running the Klocwork Servers on the default ports, ensure that you are not
already running other servers on these ports.

Ä When setting a port number with the procedure below, the projects_root directory must be writable from the
machine you're logged into.

Ä When the Klocwork Servers are running behind a firewall, the firewall needs to be configured to allow client
communication to the servers.

Ä If port 33133 is not available for use by the License Server, follow the instructions in Changing the vendor
daemon port in your license file.

To set the port used by a Klocwork Server:

1. Stop the server, if is running. See Stopping the Klocwork Servers.
2. Run the following command:

kwservice --projects-root <projects_root> set-service-property <server_name> port <port_number> 

where

Ä <projects_root> is the projects_root directory you want to use (mandatory argument)
Ä <server_name> is one of:

Ä database
Ä license
Ä klocwork

Ä <port_number> is the port to be used by the specified Klocwork Server (defaults shown in table above).
3. Restart the server. See Starting the Klocwork Servers.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Changing_the_vendor_daemon_port_in_your_license_file
http://www.klocwork.com/products/documentation/dakota/index.php?title=Changing_the_vendor_daemon_port_in_your_license_file
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Example

To set the port used by the Klocwork Server to port 8074:

kwservice --projects-root C:\Klocwork_Server\projects_root set-service-property klocwork port 8074

Making network changes that affect the host name or IP address of a host
machine
If you need to change any aspect of a server's network setup that will affect its IP address and/or its fully qualified
host name, follow the procedure below to ensure that Klocwork applications continue to function properly.

Note: This includes the situation where you need to disconnect a Windows computer from the network, when you
have installed both the servers and the clients on the computer.

To make a network change that will affect the host name or IP address of a machine hosting Klocwork Servers:

1. Stop the Klocwork Servers. See Stopping the Klocwork Servers.
2. Make your network configuration change (or disconnect your computer from the network).
3. If the Klocwork License server is running on the machine, make a backup copy of the Klocwork license file, then

edit the license file to change the host name or IP address to the new host name or IP address.
4. Start the Klocwork Servers again. See Starting the Klocwork Servers.
5. Communicate the changes to anyone else who needs to know (for example, IT team, Klocwork administrator,

build engineer, or development teams).

Starting the Klocwork Servers
<yambe:breadcrumb>Server and database administration|Server and database admin</yambe:breadcrumb>The
Klocwork Servers must be running before you perform project management tasks, and before Klocwork Insight can
access data and reports.

Note for Windows: Depending on your configuration, you may be running the Klocwork Servers as Windows
services, or as regular processes under the control of the kwservice utility. If you are running the Klocwork Servers
as Windows services, you must use Windows Services administration to start, stop and check the Klocwork Servers,
rather than kwservice or the Start Menu shortcuts.

Requirements for starting servers
Ä Either you must put a copy of your Klocwork license in the <projects_root>/licenses directory

or
If you will use your organization's FLEXlm license manager, you must configure a path to that server during
installation, or with the kwservice set-service-property command. See Setting the host name of the Klocwork
servers.

Ä You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands locally.

Ä The path to the projects_root must be the same on all server hosts.
Ä The path to the Klocwork executables must be the same on all server hosts.
Ä The user starting the Klocwork Servers must have write access to the projects_root directory.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_set-service-property
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_host_name_of_the_Klocwork_servers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Viewing_and_changing_Klocwork_server_settings%23Setting_the_host_name_of_the_Klocwork_servers
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Starting the servers as regular processes
To start all of the Klocwork Servers as regular processes, run the following command:

kwservice --projects-root <projects_root> start 

where <projects_root> is the projects_root directory you want to use

To start one of the Klocwork Servers, run the following command:

kwservice --projects-root <projects_root> start [<server_name>] 

where

Ä <server_name> can be one of:

Ä database
Ä license
Ä klocwork

Ä <projects_root> is the projects_root where the servers are running

Tip: On Windows, you can also start the Klocwork Servers by clicking Start > All Programs > Klocwork 9.6 >
Start Klocwork Servers.

Examples

To start all Klocwork Servers:

kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" start 

To start the Klocwork Server:

kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" start klocwork 

You see messages indicating that the servers have been started, showing the server host name and port number and
the path to the projects_root. For example:

Using projects root: C:\Klocwork\projects_root

Local Host is: serverxyz.com [13.1.1.142]

Starting License Server [started on serverxyz.com:27000] (projects

root is C:\Klocwork\Server 9.6\projects_root)

Starting Database Server [started on serverxyz.com:3306] (projects

root is C:\Klocwork\Server 9.6\projects_root)

Starting Klocwork Server [started on serverxyz.com:8080]

Starting the servers as Windows services
Your Windows services may already be running. During installation you have the option of automatically starting
the Klocwork Servers as Windows services when installation has completed.

Note: It is not possible to run two sets of the Klocwork Servers as Windows Services on one host when the servers
are of the same Klocwork version. For more details, see Moving or creating additional projects root directories.

When running the Klocwork servers as Windows Services, the Klocwork Server is dependent on the Database
Server. This means:

Ä When you start or restart the Klocwork Server, the Database Server will also start.
Ä When you stop the Database Server, the Klocwork Server will also stop.

To start or restart one or more Klocwork Servers as Windows services, use the Windows Services Administration
Control Panel.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Moving_or_creating_additional_projects_root_directories
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Alternatively, use the following commands:

net start "Klocwork 9.6 Database Server"

net start "Klocwork 9.6 License Server"

net start "Klocwork 9.6 Server"

What's next?
Now it's time to set up and analyze an integration project. See Integration build analysis.

Stopping the Klocwork Servers
<yambe:breadcrumb>Server and database administration|Server and database
admin</yambe:breadcrumb>Warning: If possible, schedule stopping the servers when users will not be using
Klocwork applications, so that users do not lose data. Warn users that you plan to stop the servers.

Typically, once you have started the Klocwork servers, you leave them running indefinitely to handle information
requests from Klocwork client applications. Occasionally, you may have to stop the servers when you are, for
example, shutting down the machine running the server, upgrading your Klocwork software, replacing the license
file, or changing your server configuration. Before you change server properties such as host name and port number,
you must stop the Klocwork server whose properties you want to change.

Note for Windows: If you are running the Klocwork servers as Windows Services, which is the default setup, you
must use Windows Services administration to start, stop and check the Klocwork servers, rather than kwservice or
the Start Menu shortcuts.

Requirements for stopping servers
Ä You must be logged into the host machine directly. You cannot stop servers remotely.
Ä Prior to shutting down all Klocwork servers, advise users of Klocwork clients to shut down client applications. If

they do not do so, they may lose data.

Note: The messages indicating that the servers have stopped actually occur while they are stopping. Before you start
another process such as restarting the servers or doing a backup, wait a minute.

Stopping the servers running as regular processes
To stop all of the Klocwork servers running as regular processes, run the following command:

kwservice --projects-root <projects_root> stop 

where <projects_root> is the projects_root directory you want to use

To stop one of the Klocwork servers, run the following command:

kwservice --projects-root <projects_root> stop <server_name> 

where

Ä <server_name> can be one of:

Ä database
Ä license
Ä klocwork

Ä <projects_root> is the projects_root where the servers are running

http://www.klocwork.com/products/documentation/dakota/index.php?title=Integration_build_analysis
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Tip: On Windows, you can also stop the Klocwork servers by clicking Start > All Programs > Klocwork > Stop
Klocwork Servers.

Examples

To stop all Klocwork servers:

kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" stop 

To stop just the Klocwork Server:

kwservice --projects-root "C:\Klocwork\Server 9.6\projects_root" stop klocwork 

You see messages indicating that the servers have been stopped. For example:

Using projects root: C:\Klocwork\Server 9.6\projects_root

Local Host is: serverxyz.com [13.1.1.142]

Stopping License server [stopped]

Stopping Database server [stopped]

Stopping Klocwork server [stopped]

Tip: On Windows, you can also stop the servers from the Start Menu. Click Klocwork > Stop Klocwork Servers.

Stopping the servers running as Windows services
When running the Klocwork servers as Windows Services, the Klocwork Server is dependent on the Database
Server. This means:

Ä When you start or restart the Klocwork Server, the Database Server will also start.
Ä When you stop the Database Server, the Klocwork Server will also stop.

To stop one or more Klocwork servers running as Windows services, use the Windows Services Administration
Control Panel.

Alternatively, use the following commands:

net stop "Klocwork 9.6 Server"

net stop "Klocwork 9.6 Database Server"

net stop "Klocwork 9.6 License Server"
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kwservice
<yambe:breadcrumb self="kwservice">Command_Reference|Command reference</yambe:breadcrumb>kwservice
administers the Klocwork Servers.

You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands locally.

For the remaining kwservice subcommands, the projects_root directory must be visible from the machine you're
logged into.

Usage
kwservice [common-options] <subcommand> [options]

Example

kwservice --projects-root C:\Klocwork 9.6 Server\projects_root start license

Common options

Name (and short name) Description

--help display this help

--projects-root (-r) path to projects_root directory where the servers are running. Mandatory for all kwservice commands.

--verbose print verbose information about program execution, which can help to troubleshoot errors

--version print version information

Examples variables
The examples in this article use the following variables:

Ä <server_name> can be one of:

Ä database
Ä license
Ä klocwork

Ä <projects_root> is the projects_root where the servers are running

kwservice check
Use the kwservice check command to check the status of all of the Klocwork Servers, or an individual Klocwork
Server.

Note for Windows: If you are running the Klocwork Servers as Windows Services, which is the default setup, you
must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or
the Start Menu shortcuts.

Usage

kwservice --projects-root <projects_root> check [<server_name>]

Examples

To check the status of all Klocwork Servers:
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kwservice --projects-root C:\Klocwork\projects_root check

To check the status of the License Server:

kwservice --projects-root C:\Klocwork\projects_root check license 

kwservice get-service-properties
Use the kwservice get-service-properties command to view the host name and port number of the Klocwork servers.

Usage

kwservice --projects-root <projects_root> get-service-properties <server_name>

Examples

kwservice --projects-root C:\Klocwork\projects_root get-service-properties klocwork

kwservice list-services
Use this command to list the Klocwork Servers.

Usage

kwservice --projects-root <projects_root> list-services 

Examples

kwservice --projects-root C:\Klocwork\projects_root list-services 

kwservice restart
Use this command to stop and then restart all or individual Klocwork Servers in one step.

Note for Windows: If you are running the Klocwork Servers as Windows Services, which is the default, you must
use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or the
Start Menu shortcuts.

Note: You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands servers locally.

Usage

kwservice --projects-root <projects_root> restart [<server_name>] 

Examples

To restart all Klocwork Servers:

kwservice --projects-root C:\Klocwork\projects_root restart 

To restart the License server:

kwservice --projects-root C:\Klocwork\projects_root restart license 
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kwservice set-service-property
Use this command to set properties for the Klocwork servers.

Note: You must stop the relevant server before running this command. See kwservice stop.

Usage

kwservice --projects-root <projects_root> set-service-property <server_name> <property> <value> 

Ä <property> is one of the properties from the table below

Property Description Default value Applies to these servers

host the host name of the specified server localhost all

port the port number used by the specified server License Server: 27000
Database Server: 3306
Klocwork Server: 8080

all

kwservice setup
Use this command to set up and initialize additional projects_root directories.

A single projects_root directory is created automatically during installation.

A projects_root directory is the data location for the Klocwork servers and applications. It contains Klocwork server
settings and information about integration projects and build analysis runs. It also stores the Klocwork license file.
The default location is <Server_install>/projects_root.

If you need to create additional projects_root directories, contact Klocwork Customer Support [4] for more
information.

Usage

kwservice --projects-root <new_projects_root> setup [options] 

where:

Ä <new_projects_root> is the path to the projects_root you want to create. Note that the parent directory of this
directory must already exist.

Important: The maximum length of the path to the projects_root is 68-72 characters, depending on the length of the
Database server (mysql) port number (1-5 digits).

Examples

kwservice --projects-root C:\Klocwork\projects_root_2 setup 

Options

mailto:support@klocwork.com
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Name Description

--license <arg> specify the license file. Use this option to copy the specified license file to the new projects_root directory.

--old-pr <arg> specify an existing projects_root directory. Use this option to copy server settings from an existing projects_root.

kwservice start
Use this command to start all or individual Klocwork Servers.

Note for Windows: If you are running the Klocwork Servers as Windows Services, which is the default setup, you
must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or
the Start Menu shortcuts.

Note: You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands on the servers locally.

Usage

kwservice --projects-root <projects_root> start [<server_name>] 

Examples

To start all Klocwork Servers:

kwservice --projects-root C:\Klocwork\projects_root start 

To start the Klocwork Server:

kwservice --projects-root C:\Klocwork\projects_root start klocwork 

Note on migrate option

The --migrate option is used to migrate a projects_root from a previous version of Klocwork Insight. For information
on upgrading, see Upgrading from a previous version.

kwservice stop
Use this command to stop all or individual Klocwork Servers.

Note for Windows: If you are running the Klocwork Servers as Windows Services, which is the default setup, you
must use Windows Services administration to start, stop and check the Klocwork Servers, rather than kwservice or
the Start Menu shortcuts.

Note: You can manage the Klocwork Servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands servers locally.

Usage

kwservice --projects-root <projects_root> stop [<server_name>]

Examples

To stop all Klocwork Servers:

kwservice --projects-root C:\Klocwork\projects_root stop 

To stop the Klocwork Server:

kwservice --projects-root C:\Klocwork\projects_root stop klocwork 
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Testing your installation

Testing your installation
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>To test your Klocwork
installation, you can either use one of the Klocwork sample projects, or create and analyze your own sample project.

Use one of the Klocwork sample projects
In <Klocwork_install>\samples, there are two directories:

Ä csvtosql (a sample Java project)
Ä Demosthenes (a sample C/C++ project)

Each directory contains a sample project and a readme file that shows you how to set up some sample analyses you
can use to explore or demonstrate Klocwork.

Note: To successfully build a sample project on Unix you should have GNU make, GCC and bash.

Create and analyze a sample project
To test your Server package installation, you can create and analyze a sample project and then view the results of
your analysis in Klocwork Review:

Ä C/C++ integration build analysis - Cheat sheet
Ä Java integration build analysis - Cheat sheet
Ä C# integration build analysis - Cheat sheet

http://www.klocwork.com/products/documentation/dakota/index.php?title=C/C%2B%2B_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=Java_integration_build_analysis_-_Cheat_sheet
http://www.klocwork.com/products/documentation/dakota/index.php?title=C-sharp_integration_build_analysis_-_Cheat_sheet
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What to communicate to the team
<yambe:breadcrumb>Installing Klocwork Insight|Installation</yambe:breadcrumb>Your team of developers,
managers, build engineers(s) and administrator(s) need to know the following:

Ä the location of the installation packages (if developers will install their own Klocwork tools)
Ä the URL of the Klocwork Server, so that managers and developers can access Klocwork Review and Klocwork

Inspect
Ä that the URL of the Klocwork Server with "/documentation" added to it will give them all of the Klocwork online

documentation
Ä the location of the projects_root directory (Klocwork administrators only)
Ä the host and port of the License Server
Ä who has permission to start and stop the Klocwork Servers, under what user ID, and, for Windows, whether the

servers must be managed as Windows Services

If anyone else needs to access the database (either the Klocwork Database Server or a separate MySQL database),
for example, to do backups, and you have locked the database with a password, give the person the password. See
Setting a password for the Klocwork database for more information.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Projects_root_directory
http://www.klocwork.com/products/documentation/dakota/index.php?title=Setting_a_password_for_the_Klocwork_database
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Troubleshooting

Repairing a Windows installation of Klocwork
Insight
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>If files in the Klocwork
installation were accidentally damaged or deleted, you can repair the installation.

You may discover that your Klocwork installation is damaged, for example, if you are attempting to uninstall
Klocwork and see the error message "Fatal error: Cannot uninstall".

If this occurs, click OK in the error message dialog to cancel the uninstallation, perform the following repair
procedure, and then run the uninstallation procedure again.

To repair a Klocwork installation on Windows:

1. In the Start menu, click Control Panel > Add or Remove Programs.

The Add or Remove Programs dialog appears.
2. Select the Klocwork package you want to repair, and select Click here for support information.

The Support Info dialog for the selected Klocwork package appears.
3. Click Repair.

The installation is restored to a clean state.

See also:

Ä Uninstalling Klocwork Insight
Ä Installing Klocwork Insight
Ä Troubleshooting

http://www.klocwork.com/products/documentation/dakota/index.php?title=Troubleshooting
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Package Load Failure occurs in Visual Studio
after I install patch
<yambe:breadcrumb>Visual Studio troubleshooting</yambe:breadcrumb>You can either:

Ä uninstall the patch and install the last full version of the Klocwork User installer, or
Ä from the <user_install>\inforceVSNET directory, run the following command:

regsvr32 IfPkgVS2005.dll

Error reading setup initialization file during
installation
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb> If you see the following error
during installation on Windows:

Error reading setup initialization file

Ensure that your Windows system drive (normally the C: drive) has free space. The Windows installer requires space
on the system drive, even if you install Klocwork on a different drive.

Klocwork support for non-ASCII encoding
<yambe:breadcrumb>Reference</yambe:breadcrumb>Klocwork Insight 8.1 or later is fully internationalized,
meaning that it accepts multibyte characters, such as Japanese, in:

Ä source-file contents (note that for C/C++, multibyte characters are allowed only in comments and strings)
Ä source-file names and paths (see Limitations related to internationalization)
Ä tables directory paths
Ä comments on detected issues
Ä custom checker help files (Note that multibyte characters are not permitted in issue codes)
Ä configuration files
Ä user authentication management (for example, LDAP access control)
Ä Checker Studio

Characters which are used in file system paths must be representable in your current encoding. For example, if
Japanese characters are used in paths to source files or to the tables directory, then the current encoding should be
appropriately set to support Japanese characters. On Windows, this means that the language for non-unicode
programs must be set to Japanese. To change this property, go to Control Panel > Regional and Language options
> Advanced, select Japanese, and restart your computer.

See also:

Ä Limitations related to internationalization
Ä kwconv

http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Limitations_related_to_internationalization
http://www.klocwork.com/products/documentation/dakota/index.php?title=Tables_directory
http://www.klocwork.com/products/documentation/dakota/index.php?title=Writing_custom_C/C%2B%2B_checkers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Configuration_files_you_can_edit
http://www.klocwork.com/products/documentation/dakota/index.php?title=Setting_up_access_control
http://www.klocwork.com/products/documentation/dakota/index.php?title=Writing_custom_C/C%2B%2B_checkers
http://www.klocwork.com/products/documentation/dakota/index.php?title=Release_Notes%23Limitations_related_to_internationalization
http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwconv
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Unable to start Klocwork Servers following
Windows installation
<yambe:breadcrumb>Server and database administration|Server and database admin</yambe:breadcrumb> If you
see one of the following messages after installing the Klocwork Server package on Windows:

Ä Error 1920. Service Klocwork 9.6 Server (Klocwork 9.6 Server) failed to start. Verify that you have sufficient
privileges to start system services.

Ä Service Klocwork 9.6 License Server failed to start. See installation log for more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that you
specified during installation of Insight 9.6. It is not possible to run two versions of a server on the same port.

You need to set a different port number for the 9.6 Klocwork Server and/or 9.6 Klocwork License Server with
kwservice set-service-property, and then start the servers.

See also

Ä Installing Klocwork Insight

IntelliJ IDEA installation not detected; plugin not
installed
<yambe:breadcrumb>IntelliJ IDEA troubleshooting</yambe:breadcrumb>The IDEA plug-in may not be detected if:

Ä (on Windows) if you installed IntelliJ IDEA 8.x by unzipping files, rather than with the MSI installer, the
Klocwork Insight 9.x User package installer will not be able to detect your IntelliJ IDEA installation, and the
plug-in will not be installed.

Ä (on Linux) you didn't specify the directory where IntelliJ IDEA is installed on your machine with the
--idea-dir installation option.

Windows
You will need to force the IntelliJ IDEA plug-in installation from the command line:

<installer.exe> /v"IDEA=1 IDEAINSTALLDIR=<idea_install>"

where

Ä <idea_install> is the directory where IntelliJ IDEA is installed; surround the path in quotation marks if it contains
spaces

For example:

kw-user-installer.9.6.0.0.windows.exe /v"IDEA=1 IDEAINSTALLDIR=\"C:\IntelliJ IDEA\""

For more details on running the Windows command-line installer, see Unattended installation on Windows.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_set-service-property
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Linux
1. Delete the <user_install> directory. This will uninstall the user package.
2. Re-install the user package, specifying the --idea-dir option:

<installer.sh> --idea-dir <idea_install> <user_install> [KJ_IDEA]

where

Ä <idea_install> specifies where IntelliJ IDEA is installed on your machine; surround the path in
quotation marks if it contains spaces

Ä <user_install> is the location where you want to install Klocwork; surround the path in quotation marks
if it contains spaces

Ä KJ_IDEA indicates that only the IDEA plug-in is to be installed (optional)

For example:

kw-user-installer-9.6.1.1.linux.sh -a --idea-dir "/home/jlee/JetBrains/IntelliJ IDEA 9.0" "/opt/klocwork/user 9.6" KJ_IDEA

For more details on installing the user package, see Installing the Klocwork User package on Unix.
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Uninstalling

Uninstalling Klocwork Insight
<yambe:breadcrumb>Installing_Klocwork_Insight|Installation</yambe:breadcrumb>

Before you uninstall
If you will be modifying or uninstalling a Server package or connected desktop installation, you must stop the
Klocwork Servers first. See Stopping the Klocwork Servers.

If you are uninstalling the Server package, in addition to stopping the servers, you should also make a backup copy
of your projects_root directory and any configuration files you modified, such as kwfilter.conf). For Unix and
Windows, compiler configuration files are located in <server_install>/config; for Mac they are located at
/Library/Frameworks/KlocworkServer.framework/<version>/config. For more information
about backing up data, see Backing up Klocwork data.

While the Windows version of the Klocwork Server package won't uninstall the projects_root directory or
configuration files, it's a good idea to make a backup of these directories to be on the safe side, particularly if you're
uninstalling a version previous to 7.7. For Unix systems, there is no automated uninstall, so make sure you back up
your projects_root and any other data files you want to keep and store them outside your Server installation
directory. Then you can delete the Server installation directory.

See also Repairing a Windows installation of Klocwork Insight.

Uninstalling on Windows
Note: Uninstalling the User package uninstalls the plug-in from Visual Studio and IntelliJ IDEA. You must uninstall
the update site to remove the plug-in from Eclipse.

Viewing installed components or modifying your installation on Windows
Use the procedure below if you want to remove one or more Klocwork components from either the Server or User
package, or if you need to check what components are currently installed. For example, if you need to uninstall
Klocwork before installing a new version, you should check what components are currently installed before
uninstalling, so that you can install the same components for the new version.

To view installed components or partially uninstall Klocwork:

1. In the Start menu, go to Control Panel > Add or Remove Programs.

Windows 7: From the Control Panel window, under Programs, select Uninstall a program.
2. Scroll to and click the Server or User package you want information on.
3. To find information about patches, make sure the Show updates checkbox is selected at the top of the Add or

Remove Programs panel.

Windows 7: Click View installed updates in the upper right.

The installed patches will be displayed under the Klocwork installation package entry.
4. Click Change.

Windows 7: Right-click the Klocwork installation package and select Change.

The Welcome screen for the Modification wizard appears.

http://www.klocwork.com/products/documentation/dakota/index.php?title=Backing_up_Klocwork_data
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5. Click Next.

The Program Maintenance panel appears.
6. Select Modify and click Next.
7. The Custom Setup screen appears. Click through it to see what components (features) are installed.

Note: This symbol indicates a component that is installed: 
8. If you are simply viewing installed components:
9. Record which components are installed.
10. Click Cancel.
11. Click Yes when asked if you are sure.
12. Click Finish.
13. If you want to uninstall certain components, or install components you did not previously install:
14. For the components you want to uninstall, click This feature will not be available.

For the components you want to install, click This feature, and all subfeatures, will be installed on local hard
drive.

15. Click Next.

The Ready to Modify the Program screen appears.
16. Click Install.

The features you selected will be modified.
17. Click Finish.

Uninstalling Klocwork from a Windows machine
Note: You can also uninstall Klocwork with the Windows Add or Remove Programs Control Panel, but you will not
get logging information.

To remove a Klocwork software package:

1. Run the following command:

<installer.exe> /X

where <installer.exe> is the package you want to uninstall
2. The Choose Setup Language screen appears.

Select the appropriate language and click OK.
3. When prompted, click Yes to uninstall the product.

An uninstallation log file will be saved to %USERPROFILE%\Local Settings\Temp. The log file is
named Klocwork<release-number>-<package>.log. For example, the uninstallation log file for
the Klocwork 9.6 Server package is named Klocwork9.6-Server.log.

Uninstalling in unattended mode on Windows
To run uninstallation in unattended mode from a Windows machine, enter the following command:

<installer.exe> /S /v"/qn REMOVE=ALL"

where <installer.exe> is the package you want to uninstall

An uninstallation log file will be saved to %USERPROFILE%\Local Settings\Temp. The log file is named
Klocwork<release-number>-<package>.log. For example, the uninstallation log file for the Klocwork
9.6 Server package is named Klocwork9.6-Server.log.

http://www.klocwork.com/products/documentation/dakota/index.php?title=File:Uninstall_this_feature_installed.jpg
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Uninstalling on Unix

Viewing installed components on a Unix machine
If you are upgrading to a new version of Klocwork, check what components are currently installed before
uninstalling, so that you can install the same components from the new version.

To list installed components (features), run the following command:

kwupdate [option ...] --list

See kwupdate for the full list of options.

Uninstalling from a Unix machine
Note: Uninstalling the User package uninstalls the plug-in from IntelliJ IDEA. You must uninstall the update site to
remove the plug-in from Eclipse.

To uninstall on Unix, simply delete the Server package and/or User package installation directory.

Uninstalling on Mac
Note: Uninstalling the User package uninstalls the plug-in from IntelliJ IDEA. You must uninstall the update site to
remove the plug-in from Eclipse.

To uninstall, delete the following directories:

/Applications/Klocwork Server 9.6 

/Applications/Klocwork User 9.6 

/Library/Frameworks/Klocwork*.framework 

/usr/local/kw 

Uninstalling the plug-in from Eclipse and IntelliJ IDEA
For Eclipse, uninstalling the User package does not uninstall the plug-in; to uninstall the plug-in, follow the steps in
this section.

For IntelliJ IDEA, you have two choices: you can uninstall the User package as detailed above, or uninstall just the
plug-in by following the steps in this section.

Eclipse
To uninstall the Klocwork plug-in from Eclipse:

Eclipse 3.4 Eclipse 3.5 and 3.6

1. From the Help menu, choose Help > Software Updates > Manage Configuration.
2. The Product Configuration dialog appears.
3. Expand the items in the navigation pane until you see the Klocwork feature.
4. Right-click the Klocwork feature and choose Uninstall, and click Yes to confirm that you

want to disable this feature.

1. From the Help menu, choose Help > About
Eclipse"

2. Click Installation Details.
3. Select the Klocwork plug-in from the list and

click Uninstall.

When you're prompted to restart Eclipse, click Yes.

Once Eclipse restarts, the Klocwork buttons and menu items are no longer present. If you haven't uninstalled the
Klocwork User package as described above, your Klocwork projects remain in their storage location.



Uninstalling Klocwork Insight 69

IntelliJ IDEA
1. Go to File > Settings.
2. Under IDE Settings, click Plugins.
3. Right-click Klocwork for Java in IntelliJ IDEA and select Uninstall.
4. Close IntelliJ IDEA.
5. Restart IntelliJ IDEA to confirm the removal by ensuring that the Klocwork button has been removed.

Note: You must restart IntelliJ IDEA after uninstallation, before you install a new version of Insight.

Unable to start Klocwork Servers following
Windows installation
<yambe:breadcrumb>Server and database administration|Server and database admin</yambe:breadcrumb> If you
see one of the following messages after installing the Klocwork Server package on Windows:

Ä Error 1920. Service Klocwork 9.6 Server (Klocwork 9.6 Server) failed to start. Verify that you have sufficient
privileges to start system services.

Ä Service Klocwork 9.6 License Server failed to start. See installation log for more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that you
specified during installation of Insight 9.6. It is not possible to run two versions of a server on the same port.

You need to set a different port number for the 9.6 Klocwork Server and/or 9.6 Klocwork License Server with
kwservice set-service-property, and then start the servers.

See also

Ä Installing Klocwork Insight

http://www.klocwork.com/products/documentation/dakota/index.php?title=Kwservice%23kwservice_set-service-property
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License
Copyright Ç 1998-2012 Klocwork Inc.
All rights reserved
This document, as well as the software described in it, is furnished under license and may only be used or copied in accordance with the terms of such license. The information contained herein is the property of Klocwork Inc. and is
confidential between Klocwork Inc. and the client and remains the exclusive property of Klocwork Inc. No part of this documentation may be copied, translated, stored in a retrieval system, or transmitted in any form or by any means,
electronic, mechanical, photocopying, recording or otherwise without the prior written permission of Klocwork Inc.
If you find any problems in the documentation, please report them to us in writing. Klocwork Inc. does not warrant that this document is error-free.
Klocwork and Klocwork Truepath are registered trademarks of Klocwork Inc. Klocwork Insight, Klocwork Inspect, and Klocwork Review are trademarks of Klocwork Inc.
All other trademarks are the property of their respective owners. All help content for Klocwork's MISRA checkers is copyright by MIRA Ltd, on behalf of the MISRA Consortium.
Copyright notices for third-party software are contained in the file 3rdparty_copyright_notices.txt, located in the Klocwork installation directory.
Klocwork Inc.
Toll-free telephone (North America): 1-866-556-2967
E-mail: sales@klocwork.com or support@klocwork.com
Web site: http:/ / www. klocwork. com
In the U.S.:
8 New England Executive Park, Suite 180 Burlington, Massachusetts 01803 USA
In Canada:
30 Edgewater Street, Suite 114 Ottawa, Ontario Canada K2L 1V8
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